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Cette version d'UniLogic, publiée en mai 2026, apporte des améliorations de sécurité pour protéger les automates 
de la série UniStream Pro (B10/C10) contre les cybermenaces. 

(Remerciements particuliers à SemanticGuard pour sa divulgation responsable.) 

Nous recommandons vivement de suivre les mesures de cybersécurité décrites dans l'onglet  
cybersécurité disponible sur le site web www.unitronics.com 

Cette version d'UniLogic corrige les vulnérabilités découvertes suivantes : 

• CVE-2026-45449 

• CVE-2026-45450 

• CVE-2026-45451 

• CVE-2026-45452 

 

Unitronics recommande fortement à tous les utilisateurs utilisant des applications existantes sur les 
automates de la série UniStream Pro (B10/C10) de mettre à jour vers cette version. 

 

Une mise à jour du logiel de conversion de données Unistream 1.0.26 est disponible ! 

Cette version ajoute la prise en charge et la vérification des fichiers signés numériquement créés par les 
automates UniStream. Le logiciel est disponible en téléchargement sur le site web d'Unitronics, dans la section 
Utilitaires logiciels de la page UniLogic. 

Nouvelles fonctionnalités 

Gestionnaire de 
Firmware 

Vous pouvez désormais télécharger les fichiers Firmware de l’API directement 
depuis le cloud, sans qu'ils soient intégrés à l'installation du logiciel. 

 

Cela permet de maintenir le Firmware à jour indépendamment des versions 
d'UniLogic, réduit la taille de l'installation et vous donne un contrôle précis sur les 
versions de Firmware présentes sur votre machine. 

Améliorations 
IHM/ Images Web 

Prise en charge des images SVG avec palette de couleurs modifiable 

UniLogic prend désormais en charge les images SVG (Scalable Vector Graphics) 
dans tous les éléments d'image IHM et WebServer : Image fixe, Variable image 
binaire, Variable liste d'images et Variable plage d'images. Les fichiers SVG 
peuvent être parcourus et assignés de la même manière que les autres formats 
d'image tels que PNG et JPG. 



Le format SVG étant vectoriel, les images s'adaptent proprement à toute taille 
d'élément sans perte de qualité. Une case à cocher Conserver les proportions 
vous permet de choisir si l'image conserve ses proportions d'origine ou s'étire 
pour remplir la zone de l'élément. 

La bibliothèque d'images intégrée d'Unitronics a été enrichie d'une nouvelle 
collection UniSVGPics d'images SVG prêtes à l'emploi. 

 

Texte structuré 
(ST) 

Cette version transforme l'éditeur ST en une plateforme de développement IEC 
61131-3 complète. De nouveaux éléments de langage, blocs fonctionnels et 
capacités d'édition sont disponibles directement dans l'éditeur ST aux côtés des 
fonctions Ladder existantes. 

Blocs fonctionnels IEC 61131-3 : 

• UniLogic ST prend désormais en charge le jeu complet de blocs 
fonctionnels standard IEC 61131-3 avec instances à état et prise en 
charge de la surveillance en ligne. 

Nouveaux blocs fonctionnels : 

a. RS / SR –  Reset et Set pour la logique de maintien. 

b. R_TRIG / F_TRIG – Détection de front montant et descendant 
(impulsions sur un seul cycle). 

c. CTU / CTD / CTUD – Compteurs croissant, décroissant et 
bidirectionnel. 

d. TON / TOF / TP – Temporisateurs standard à montée, descente et 
impulsion. 

e. RTC – Bloc fonctionnel horloge temps réel prenant en charge les 
valeurs DATE_AND_TIME. 

Tous les temporisateurs prennent en charge le type IEC TIME et exposent le 
temps écoulé (ET) en direct lors de la surveillance en ligne. Les blocs de 
temporisation UniLogic précédents restent entièrement pris en charge. 

Types de données et prise en charge du temps : 

• IEC Littérale de durée. 

• Arithmétique date/heure avec + et – 

• Affichage en ligne formaté pour les valeurs de temps 

• Fonctions de conversion entre horodatages et valeurs numériques. 

Mises à jour des conversions de types : 

• UniLogic prend désormais en charge tous les styles de conversion 
conformes à la norme IEC. Les fonctions de conversion précédentes 
restent prises en charge avec compatibilité du suffixe _UNI_. 

Nouvelles fonctions et gestion des chaînes : 

• Fonction MUX – sélectionne l'une des 32 valeurs possibles via une entrée 
d'index. 

• Accès ST aux opérations Ladder (RESET_NUMERIC, IN_RANGE, 
COPY_STRUCT et COMPARE_STRUCT). 

• Fonctions mathématiques avancées. 

• Prise en charge mixte STRING / WSTRING. 

Améliorations de l'éditeur ST : 

• Création de variables à la volée. 

• IntelliSense – indications de paramètres en ligne affichant les types de 
paramètres et navigation de surcharge lors de la saisie. 

• Édition en ligne avec Synchronisation rapide. 

• Diagnostics en ligne. 



Mises à jour des conversions de types pour les énumérations : 

• UniLogic prend désormais en charge tous les styles de conversion 
conformes à la norme IEC. Les fonctions de conversion précédentes 
restent prises en charge avec compatibilité du suffixe _UNI_. 

Énumérations : 
ENUM 

UniLogic prend désormais en charge les énumérations du projet pour définir le 
type, le nom et la valeur utilisées dans l'ensemble du code ST. 

Exemple concret : imagine que tu as un état machine avec 3 états. Sans 
énumération, tu écris ça dans ton code ST : 

IF etat = 0 THEN ...  (* c'est quoi 0 ? *) 

IF etat = 1 THEN ...  (* et 1 ? *) 

IF etat = 2 THEN ... 

Avec une énumération, tu définis une fois : 

TYPE EtatMachine : (ARRET, DEMARRAGE, PRODUCTION) END_TYPE 

Et ton code devient : 

IF etat = ARRET THEN ... 

IF etat = DEMARRAGE THEN ... 

IF etat = PRODUCTION THEN ... 

 

Fonctionnalités des 
énumérations : 
ENUM 

Prise en charge des types entiers  

• Modes de validation strict et non strict. 

• Intégration ST – Propose automatiquement la liste des valeurs 
possibles. 

• Prise en charge de l'importation. 

Annuler / Rétablir UniLogic prend désormais en charge des opérations Annuler et Rétablir 
améliorées dans les éditeurs Ladder, ST/C, IHM et Web. 

Serveur VNC Lors de l'utilisation d'un automate API, la résolution du serveur VNC est 
désormais automatiquement dérivée de la résolution de l’écran. La 
configuration manuelle n'est plus nécessaire. 

Message composer Vous pouvez désormais localiser l'endroit où un message est utilisé dans votre 
application directement depuis le message composer. Faites un clic droit sur 
n'importe quel message et sélectionnez Rechercher toutes les références pour 
voir tous les endroits où ce message est référencé. Cliquez sur n'importe quel 
résultat pour y accéder directement. 

UniCloud UniCloud synchronise désormais automatiquement les ajouts et suppressions 
de tags vers les automates UniStream connectés lorsqu'un type d'actif est mis 
à jour – aucun téléchargement manuel vers l'automate ni intervention sur site 
n'est requis. 

LF : Calculer l'angle Utilisez cette fonction Ladder pour calculer la position angulaire d'un encodeur 
à partir de sa position actuelle et de sa résolution. 

 

Fonctionnalités supplémentaires 

• UAC : Les règles de mot de passe prennent désormais en charge l'obligation de lettres majuscules et 
minuscules. 



• La fonction Ladder « with in Range » inclut désormais un paramètre de sortie optionnel (Hors plage), qui 
s’active lorsque la valeur en entrée A est en dehors de la plage définie. 

• Serveur/Client BACnet : Vous pouvez désormais exporter et importer les configurations de serveur et 
client BACnet via un fichier propriétaire Unitronics. 

• Structs : Vous pouvez désormais réorganiser les membres d'un Struct à l'aide d'un mode de 
réordonnancement dédié avec glisser-déposer, permettant un regroupement logique des variables et une 
meilleure lisibilité dans les tableaux de données. 

• Texte structuré : – Icônes ST dédiées dans la liste déroulante de sélection de type pour distinguer les 
types spécifiques ST. – Les tags créés dynamiquement ou ajoutés depuis la liste « Globaux utilisés » 
suivent désormais la norme ST pour les déclarations de valeurs à la mise sous tension. 

• UID-W1616T : Un nouveau groupe de filtres dédié est disponible dans UniLogic. 

 

Corrections de bogues dans cette version : 

• LF Num vers Bits : La fonction Ladder ne pouvait pas lire directement les données d'un tampon contenant 
des valeurs UINT8, bien que les données soient reçues et transmises correctement à la fonction. 

• EtherNet/IP : Certains fichiers EDS n'étaient pas analysés correctement lors de l'importation dans 
UniLogic, entraînant : – l'affichage de paramètres sans leur nom correct et leur définition incorrecte en 
UINT8. – une analyse incorrecte des données d'entrée et de sortie dans les assemblages contenant des 
tailles de membres dépendant de paramètres lorsque le membre de taille variable était défini comme 
dernier membre de l'assemblage. 

• LF Lire la ligne depuis un fichier sur SD : La fonction Ladder convertissait incorrectement le caractère 
0x0D (CR) en 0x20 (espace). 

• UniApps – Client VNC : Lors d'une tentative de connexion à une unité distante, le paramètre de délai 
d'expiration du client VNC n'était pas appliqué. Si le système était injoignable, la valeur de délai 
configurée n'était pas respectée. 

• Modbus : Lors de l'exportation et de l'importation d'une configuration Modbus Slave, l'identifiant de 
l'esclave n'était pas conservé et pouvait revenir à la valeur par défaut. 

• USBF : Lors de la création d'un USBF avec sélection de la mise à jour du Firmware, l'outil copiait tous les 
fichiers BIN sur le support, y compris les fichiers pour les modèles d'automate non pertinents pour 
l'application. 

• WebServer : Les limites Min/Max configurées pour les valeurs de présélection des temporisateurs 
n'étaient pas appliquées correctement. 

• Fichiers d'action USB : Le mot de passe VNC n'était pas inclus dans le package de mise à jour de 
l'application, empêchant la mise à jour de l'automate avec le mot de passe VNC configuré. 

• SMS : Les messages SMS contenant des caractères non ASCII envoyés via le modem KIT-50 (TRB142) 
n'étaient pas encodés correctement, entraînant la réception de messages illisibles ou leur rejet par 
l'opérateur. 

• IHM : – Dans certains cas, l'intégration d'images SVG dans l'IHM provoquait une dégradation des 
performances et ralentissait la réactivité du système. – La vérification du projet pouvait échouer dans les 
projets multi-langues en raison d'une compilation IHM parallèle, causant des différences d'affichage dans 
les écrans IHM. 

• UID-W1616T et UID-W1616R : Dans certains cas, le filtre d'entrée pour les entrées 4 à 7 ne fonctionnait 
pas correctement. Un nouveau groupe de filtres dédié a été ajouté dans UniLogic pour ces entrées 
spécifiques. 

• Texte structuré : L'importation de code ST depuis le presse-papiers ignorait la longueur de chaîne 
déclarée et créait tous les tags de chaîne avec une longueur par défaut de 5 caractères. 

• L'importation des diagnostics Motion échoue à la compilation. 

• US15 : Dans certains cas, le module adaptateur IO était identifié incorrectement par le contrôleur. 
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Ce Service Pack fournit les nouvelles fonctionnalités et corrections de bogues répertoriées ci-
dessous.

Nouvelles fonctions
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Redfish Mise à jour Redfish et Task Services Support:

Les automates UniStream prennent désormais en charge les services Redfish UpdateService et 

TaskService, ce qui permet des mises à jour asynchrones du micrologiciel et des applications 

UniLogic via des actions Redfish standard. Prend en charge les mises à jour des applications, du 

micrologiciel et combinées, y compris les mises à jour par étapes. Les inventaires de micrologiciels 

et de logiciels sont exposés via des URI Redfish, avec un contrôle du service d'exécution disponible 

via la logique Ladder.Nécessite une carte SD, une licence Redfish activée et des fichiers de mise à 

jour hébergés sur FTP/SFTP. 

Configuration du projet Redfish Object :

• Les objets Redfish prennent en charge la sélection des propriétés par objet à l'aide de modèles 
de configuration des propriétés.

• Les objets du même type peuvent exposer différents champs, et le JSON généré reflète les 
propriétés sélectionnées.

• Les structures prises en charge sont générées avec toutes les propriétés définies, quelle que 
soit la sélection de configuration.

Assistance pour les événements et alertes Redfish :

UniLogic offre désormais une prise en charge complète des événements Redfish, permettant aux 

automates programmables de générer, d'enregistrer et de transmettre des alertes conformes à la 

norme Redfish.

Nouveaux éléments d'échelle :

a. Redfish : Notifier et enregistrer l'événement - Envoyez une notification prédéfinie 

et enregistrez l'événement dans le journal système. Tous les paramètres sont 

configurés dans l'action.

b. Redfish : Notifier et enregistrer un événement indirect - Envoie et enregistre un 

événement dont les détails sont définis par des valeurs de balise. Cela permet de 

définir dynamiquement le contenu de l'événement lors de l'exécution.

c. Redfish : définir la propriété du service - Permet de modifier les paramètres du 

service Redfish lors de l'exécution.

d. Redfish : obtenir tous les abonnements - Récupère la liste des abonnements 

actifs aux événements Redfish à des fins de surveillance ou de diagnostic.



• La transmission des événements suit le modèle Redfish Event Service, y compris le filtrage et 
les tentatives de renvoi.

• Journalisation des événements : format JSON, jusqu'à 1 000 entrées

• Prise en charge complète des ressources EventService, EventDestination et Event ; jusqu'à 50 
abonnements. 

Certificate Handling Updates:

• Redfish fait désormais la distinction entre les certificats signés par l'autorité de certification et 
les certificats auto-signés.

• Les projets mis à niveau à partir d'anciennes versions associent automatiquement les anciens 
certificats aux certificats signés par l'autorité de certification.

Prise en charge du protocole TLS mutuel (mTLS) :

Redfish Server prend désormais en charge l'authentification TLS mutuelle.

• Lorsque cette option est activée, le serveur n'accepte que les connexions provenant de clients 
présentant une certification valide signée par une autorité de certification de confiance. 
L'authentification du client est vérifiée à l'aide d'un certificat CA client importé. 

Mises à jour du modèle de refroidissement :

Le modèle de refroidissement a été mis à jour vers la version 1.23 (2025.3) de Redfish.

Les unités de refroidissement, les boucles de refroidissement et les connecteurs de liquide de 
refroidissement comprennent désormais des champs d'identification supplémentaires, de 
nouvelles propriétés facultatives et une fonctionnalité améliorée de contrôle des vannes.

UniLogic génère automatiquement les structures et les ressources ActionInfo pertinentes lorsque 
ces fonctionnalités sont activées.

Commande de soupape :

Les éléments basés sur des capteurs (ValvePositionPercent) et ceux basés sur des commandes 
(ValvePositionControlPercent) peuvent être liés directement dans Redfish Space.

• Une nouvelle action de contrôle des vannes est disponible, vous permettant de définir l'état des 
vannes et la raison de cet état.

Assistance en matière de licences :

• La licence Redfish est désormais incluse dans la gestion des licences UniStream.

• Nécessite l'achat d'une licence, disponible auprès de votre représentant commercial 
Unitronics.

• Offre d'essai d'une heure : cette offre d'essai gratuite et entièrement fonctionnelle vous 

permet d'explorer les fonctionnalités de Redfish d'UniStream pendant 60 minutes à la fois.

Améliorations supplémentaires :

• Les ressources et les structures Redfish ont été étendues.

• Limite maximale de caractères pour les descriptions d'objets étendue à 100 caractères

• API REST : vous pouvez désormais sélectionner text/xml comme type de contenu et Accept pour les 
requêtes API REST.De plus, les types XML et JSON prédéfinis ont été normalisés pour utiliser 
application/xml et application/json.

2



3

• API REST : vous pouvez désormais sélectionner text/xml comme type de contenu et Accept pour les 

requêtes API REST.De plus, les types XML et JSON prédéfinis ont été normalisés pour utiliser 

application/xml et application/json.

• UniLogic prend désormais en charge le modem GSM-KIT-50 pour une fonctionnalité fiable d'envoi et de 

réception de SMS sur un réseau 4G.IO-Link prend désormais en charge un nouveau concentrateur 

analogique de température : ULK-08AIRT-M2P6 - IO-LINK HUB, 8AI Temp, MI2, IP67

• Serveur BACnet : vous pouvez désormais utiliser une liste déroulante consultable dans la propriété Units

lors de la définition des attributs d'E/S BACnet, ce qui permet une sélection plus rapide parmi l'ensemble 

complet des unités BACnet.

• Ajouts IHM: utilisez le nouveau widget Bitmap Grid pour afficher des graphiques basés sur une grille et 

contrôlés par PLC sur l'IHM. Le PLC écrit les valeurs de couleur dans une mémoire tampon et déclenche 

un rafraîchissement pour rendre le contenu visuel déterministe et reproductible.

• Remarque : pris en charge uniquement sur les plateformes iMX6.

• UniApps : Réseau>Ethernet>Débogage : les améliorations apportées à la gestion des tempêtes réseau 

introduisent une interface de débogage unifiée, permettant la configuration de la sensibilité de détection 

des tempêtes et des limites de débit de trafic pour une protection et une analyse améliorée.

• Système>Structure de détection des tempêtes : une nouvelle structure système a été ajoutée pour 

améliorer le débogage des tempêtes réseau.

• La structure enregistre les détails du dernier paquet reçu avant la détection d'une tempête, y compris 

l'adresse MAC, l'adresse IP, le type de paquet et les 100 premiers octets de données brutes du paquet.

• La structure ajoute des compteurs de tempêtes, avec des compteurs MIB Ethernet mis à jour 

périodiquement sur les plateformes IMX25/IMXRT.

• RTC : UniLogic prend désormais en charge le protocole NTP (Network Time Protocol). Une nouvelle 

fonction Ladder, Sync Clock Using NTP, a été ajoutée pour synchroniser l'heure du PLC à l'aide d'un 

serveur NTP spécifié et d'un décalage horaire optionnel. Le réseau UniStream Panel met en œuvre cette 

fonctionnalité.

• Le client VNC inclut désormais une fonction d'étirement automatique qui optimise la mise à l'échelle de 

l'affichage pour un visionnage fluide sur différentes configurations d'écran, améliorant ainsi les 

performances « tout-en-un » des contrôleurs intégrés et USL. Cette amélioration réduit la charge de 

rendu et augmente l'efficacité du système. La barre de défilement a également été améliorée pour 

faciliter la navigation.Pour activer l'étirement automatique, accédez à UniApps>Système>Réseau>Client 

VNC et sélectionnez Étirer.

Corrections apportées dans ce patch

• UniLogic pouvait se bloquer lors de la compilation de projets si les noms des balises étaient modifiés 

sans revalider les affectations d'opérandes. Cela se produisait dans deux cas de figure :

- Les projets de serveur Web, où les balises renommées provoquaient des blocages ou des liens HTML 
invalides.

- es projets utilisant des contrôles personnalisés, où les balises renommées entraînaient des références 
d'opérandes invalides ou nulles.

• IHM:

- La visionneuse PDF ne se chargeait pas correctement lorsque le fichier était manquant, affichant l'écran 

d'initialisation en raison d'une erreur de résolution du chemin d'accès (nom de fichier non ajouté au 

répertoire). Ce problème pouvait entraîner l'effondrement de l'IHM lors de l'interaction avec l'élément 

PDF.
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- Dans certains cas, l'IHM pouvait se bloquer au démarrage lors de la lecture de l'adresse MAC via le 

service IHM, rendant l'écran tactile inopérant et la bannière d'alarme bloquée.

- Une surcharge de l'IHM pouvait se produire en raison d'un plantage du contexte EGL, entraînant des 

erreurs répétées et un écran noir sur les contrôleurs USP-104-B10.

• Alarmes:

- UniLogic permettait de créer un groupe d'alarmes vide, ce qui empêchait les alarmes d'être identifiées 
correctement.

- Lors de l'utilisation du module Alarmes avec le « Mode d'affichage : Simple », la liste Résumé des 

alarmes ne se chargeait pas et provoquait le blocage de l'IHM.

- Le widget Affichage de l'état des alarmes n'affichait aucun texte dans la colonne Nom.

- La liste Résumé des alarmes n'indiquait pas les alarmes actives.

• WebServer:

- L'accès au serveur Web a généré un message d'erreur 500 (erreur interne du serveur).

- L'utilisation d'un élément Hyper Link configuré avec un lien constant (#« / ») a provoqué l'affichage de 

l'erreur 500 par le serveur Web.

- Les minuteries des pages Web configurées avec des valeurs prédéfinies modifiables (en lecture seule 

non cochée) ont provoqué une erreur interne du serveur.

• REST API:

- Lorsqu'une requête POST/PUT était créée avec contenu JSON ou XML et comprenait des balises de 

contenu, la duplication de la requête et la modification de son type de contenu en text/plain ou octet-

stream entraînaient le plantage d'UniLogic, soit immédiatement après l'ouverture de la requête dupliquée, 

soit après l'enregistrement et la réouverture du projet.

- Les caractères spéciaux tels que $ dans les paramètres de requête n'étaient pas traités correctement, ce 
qui entraînait l'échec des requêtes.

- Les requêtes REST pouvaient rester bloquées en « EN COURS » lorsque l'URL cible ne répondait pas 

comme prévu, nécessitant un redémarrage du PLC pour récupérer. Un nouveau mécanisme de délai 

d'expiration a été ajouté.

- Lors de la création d'une requête POST avec une charge utile JSON, la section Paramètres de contenu 

ne fournissait pas d'option de tampon, empêchant l'envoi de charges utiles ou de jetons volumineux.

• Redfish:

- Dans certains cas, la valeur de la vitesse de la pompe (tr/min) dans l'interface Redfish ne s'actualisait 

pas, même si la balise correspondante affichait la valeur correcte.

- Dans certains cas, le PLC pouvait signaler à tort « Too Many Registrations » (Trop d'enregistrements) 
lorsque le serveur Redfish se réinitialisait.

• Certaines actions de l'écran de chargement provoquaient un plantage QML, entraînant l'affichage indéfini 

d'un sablier et empêchant le chargement de l'écran. Le problème était dû à une syntaxe incorrecte du 

contrôle utilisateur.

• Le menu déroulant de sélection des couleurs Power Flow n'était pas disponible.

• Dans certains cas, UniLogic pouvait planter lors du changement de modèle PLC dans des projets 

contenant des tableaux de données liées.

• Ports du module COM : les membres de la structure « Time from First Byte » (Temps depuis le premier 

octet) et « Number of Bytes Waiting » (Nombre d'octets en attente) n'étaient pas mis à jour par le 

micrologiciel sur les contrôleurs US15-B10-B1.
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• UniLogic pouvait se bloquer lors de l'utilisation de l'action « Set Value » (Définir la valeur) dans un contrôle 
personnalisé.

• Serveur BACnet : la connexion au serveur échouait lorsque le fuseau horaire du PLC était défini sur une 
valeur négative.

• Client BACnet:

- Ethernet: les requêtes apériodiques pouvaient prendre 3 à 7 secondes pour s'exécuter lorsque plusieurs 

appareils étaient présents sur le réseau.

- MSTP: les réponses MSTP pouvaient être extrêmement lentes (environ 20 secondes ou plus) ou ne pas être 

reçues du tout dans certaines conditions réseau, même si les appareils répondaient normalement dans les 

outils externes.

- L'élément Ladder « BACnet Client Send Request » ne prenait en charge que les index UINT8, tandis que 

la liste des balises client autorisait des index allant jusqu'à 1023. La définition de valeurs supérieures à 

255 entraînait des échecs.

• Motion: l'importation de l'application de diagnostic VFD provoquait une erreur de compilation.

• MQTT : la charge utile du message « Last Will » était parfois envoyée de manière incorrecte, ce qui 

entraînait la réception d'un texte partiel ou corrompu par le courtier.

• Chargement de l'UDTF à partir d'un fichier : mise à jour du message d'état -5 : fichier introuvable. Vérifiez et 
corrigez le chemin d'accès au fichier.

• UniApps : le paramètre « Ignorer les fenêtres contextuelles » n'affichait pas la case à cocher 

Activer/Désactiver comme prévu sur les contrôleurs US15-B10-B1.

• Le copier-coller d'un « bouton de machine à états » pouvait entraîner le plantage d'UniLogic.

• Le téléchargement des balises conservées via UniStream Management → Télécharger les balises 

conservées pouvait échouer après l'ajout de balises non conservées à l'application. Le problème se 

produisait même lorsque les nouvelles balises n'étaient pas liées aux données conservées.

• UniLogic pouvait rester bloqué dans une boucle d'interrogation d'état après avoir formaté avec succès une 

carte SD via UniStream Management → Format SD.

• OPC UA: a modification de l'adresse IP du PLC ne mettait pas à jour le certificat du serveur OPC UA, 

empêchant les clients de se connecter après le changement d'IP.

• UAC: la compilation d'un projet avec UAC activé pouvait entraîner le plantage d'UniLogic si un élément de 

contrôle personnalisé sur un écran était configuré avec le niveau = Aucun

• RTC: Dans certains cas, des erreurs de date/heure du PLC pouvaient apparaître au démarrage ou après 

la synchronisation en raison d'un délai d'attente lors de la récupération de l'adresse IP publique dans le 

cadre de la requête API de temps.

• Ethernet/IP: les fichiers EDS (version 1.41.212) étaient analysés de manière incorrecte, ce qui entraînait 

l'échec des définitions des données d'entrée et de sortie lors de l'importation.

• UniLogic pouvait se bloquer lors du formatage de cartes SD de plus de 32 Go directement à partir d'UniApps.
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• Modbus:

- Lors de la conversion d'un esclave distant de Modbus TCP à Modbus série, la compilation 

pouvait échouer en raison d'une erreur d'ID d'esclave non valide, même après la mise à 

jour de l'ID d'esclave dans une plage valide.

- Les esclaves distants importés dans le projet s'affichaient correctement dans la configuration 

Modbus ; cependant, leurs balises de structure associées n'étaient pas disponibles pour la 

sélection dans le bloc fonctionnel Modbus Aperiodic Ladder.

- Dans certains cas, la modification de la configuration Modbus maître pouvait bloquer le PLC 
pendant letéléchargement et ne pouvait être résolue qu'en redémarrant le contrôleur.

- Dans les configurations US5-B3-R18 utilisant un esclave Modbus Ethernet avec plusieurs

unités US5-B5-TR22, la restauration de l'alimentation pouvait entraîner l'arrêt de la

communication Modbus et la perte de réactivité de l'IHM, nécessitant une déconnexion

Ethernet et un redémarrage du PLC pour rétablir le fonctionnement.

• FTP Serveur: dans certains cas, lors de l'utilisation de contrôleurs de la série USP, le 

téléchargement de fichiers vers le serveur échouait, quel que soit l'état de la case à cocher de 

configuration correspondante.

• SNMP: lors de l'utilisation de SNMPv3, les traps envoyés par les API UniLogic pouvaient être 
reçus par les outils de surveillance des traps, mais ne pouvaient pas être décodés.Il en résultait 
des données de trap illisibles et des statistiques trompeuses, les compteurs SNMPv2 étant 
incrémentés tandis que les compteurs SNMPv3 restaient inchangés. Ce problème se produisait 
lorsque l'authentification et la confidentialité étaient activées mais pas correctement appliquées. 
Le correctif applique une authentification SNMPv3 et une gestion de la confidentialité correctes.

• Serveur Web : lors du réglage des valeurs dans un tableau BIT via le tableau Web, les mises 

à jour pouvaient sembler réussies, mais étaient annulées après quelques secondes.

• Le client VNC pouvait afficher un curseur dans le coin supérieur gauche sur les plateformes iMX6, 
même lorsque l'option Curseur → Désactiver était sélectionnée.

Les résumés des modifications apportées aux versions précédentes 
commencent à la page suivante.



NOTES MAJ SERVICE 
UNILOGIC® V 1.41.213

UNISTREAM® OS 1.41.139
NOVEMBRE, 2025

En raison d'un problème technique (à compter du 5 novembre 2025), la version 1.41.212 d'UniLogic peut 

rencontrer des problèmes de connectivité avec la série de produits UniStream. 

Unitronics a publié des versions mises à jour d'UniLogic qui résolvent ce problème sans nécessiter 

de mise à niveau du système d'exploitation de l’API.

Veuillez noter que les automates programmables fonctionnant sur le terrain continuent de fonctionner 

normalement. 

Le problème affecte uniquement la connectivité entre UniLogic et l'automate programmable.

Pour rétablir la connectivité, il est obligatoire de mettre à niveau UniLogic vers la version 1.41.213.

Le résumé des modifications apportées aux versions précédentes commence à la 
page suivante.

7

UniLogic® V 1.41.213 UNISTREAM® OS 1.41.139 Novembre, 2025



NOTES MAJ SERVICE 
UNILOGIC® V 1.41.212

UNISTREAM® OS 1.41.139
SEPTEMBRE, 2025

UniLogic 1.41.212 introduit une toute nouvelle fonctionnalité logicielle puissante pour élargir le potentiel de vos 

projets : le client BACnet. Cette fonctionnalité complète la prise en charge existante du serveur IP BACnet, 

permettant aux automates UniLogic de communiquer avec des appareils compatibles BACnet IP via Ethernet et 

MS/TP série. Les deux méthodes de communication peuvent fonctionner simultanément.

Le client BACnet permet l'intégration avec plusieurs serveurs BACnet et prend en charge l'échange de données 

périodique et apériodique. La configuration est simple et s'intègre à la logique Ladder, permettant un transfert de 

données transparent entre UniLogic et les systèmes de gestion des bâtiments.

Cette version introduit également une amélioration des performances : temps de compilation amélioré. Cette mise à 

niveau offre une compilation plus rapide en résolvant les principaux limiteurs en matière de performances. Grâce à 

une optimisation complète et à l'introduction du traitement parallèle sur plusieurs composants du système, les 

temps de téléchargement ont été réduits.
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BACnet Client Cette fonctionnalité complète la prise en charge existante du serveur BACnet IP avec les 
fonctionnalités client BACnet MS/TP et BACnet IP, permettant une intégration transparente avec 
les systèmes de gestion des bâtiments grâce à une configuration simple qui s'intègre directement 
à la logique Ladder.

Veuillez noter que le client BACnet nécessite l'achat d'une licence, disponible auprès de votre 
représentant commercial Unitronics.

Unitronics vous propose une offre d'essai d'une heure pour vous permettre de découvrir cette 
nouvelle fonctionnalité passionnante. Notez que chaque fois que vous mettez votre contrôleur 
sous tension, vous pouvez redémarrer l'offre d'essai d'une heure.

Pour savoir comment activer l'offre d'essai, consultez la rubrique Client BACnet dans l'aide 
UniLogic. Remarque : le client BACnet est disponible pour les séries UniStream Built-In et 
UniStream PLC.

Nouveautés E/S 
distantes URB

La configuration matérielle propose désormais de nouveaux modules E/S pour notre gamme d'E/S 
distantes URB. Ces
modèles utilisent 18 borniers RTD (à enfichage) au lieu des 20 broches existantes (URS-08RT-2 et 
URS- 08TC-2).

• URS-08RT-8: Ce module dispose de 8 entrées températures / résistances

• URS-08TC-8: Ce module dispose de 8 entrées thermocouples

Amélioration du temps 
de compilation

Cette amélioration résout les éléments qui ralentissaient les téléchargements et accélère les 
processus de compilation, qui gagnent également en productivité.

OPC-UA Améliorations apportées à l'authentification OPC-UA :
OPC-UA prend désormais en charge l'authentification par nom d'utilisateur/mot de passe en plus 
du mode anonyme existant.

• Dans les paramètres du serveur, un nouveau champ vous permet de sélectionner le mode 
d’authentification.

• Lorsque Nom d’utilisateur / Mot de passe est sélectionné :



a. Une nouvelle section Utilisateurs est disponible, vous pouvez définir des utilisateurs, 
des mots de passe et les affecter à deux groupes fixes : Admin ou Utilisateur.

b. Dans l'espace d'adressage, une nouvelle option Niveau d'accès est disponible : Groupe 
Admin Lecture/Écriture - Les utilisateurs Admin peuvent lire et écrire des balises de 
données dans le PLC, les autres utilisateurs auront un accès en lecture seule.

OPC-40082-2 pour l'industrie du plastique/caoutchouc (EUROMAP 82.2) Prise en charge 
des dispositifs Hot Runner Device (HRD) :

• UniStream prend désormais en charge l'espace d'adressage OPC-UA HRD (Hot Runner 
Device).

• Nécessite l'achat d'une licence, disponible auprès de votre représentant commercial 
Unitronics.

• Offre d'essai d'une heure : cette offre d'essai gratuite et entièrement fonctionnelle vous 
permet d'explorer les fonctionnalités HotRunner d'UniStream pendant 1h.

• Prend en charge jusqu’à 3 zones.

• Fournit un accès structuré aux diagnostics, à la configuration de la machine, à la 

maintenance, au fonctionnement et à la gestion des zones.
REST API • Méthode de requête GET FILE : vous pouvez désormais télécharger des fichiers 

directement depuis des serveurs Web vers une carte SD ou un périphérique de stockage 
USB 

• Configuration des paramètres de fichier: Utilisez les nouveaux paramètres pour 

configurer les chemins d'accès aux fichiers, sélectionner l'emplacement de stockage, 

définir les délais d'expiration et les tentatives de réessai afin de garantir la fiabilité des 

téléchargements de fichiers.

• Méthode d'autorisation : vous pouvez désormais utiliser des jetons QAuth longs 

pouvant contenir jusqu'à 1 100 caractères (contre 256 auparavant), avec un stockage 

basé sur une mémoire tampon pour une intégration API transparente.
Améliorations 
apportées à la gestion 
des cartes SD

• Retrait sécurisé de la carte SD : utilisez cette action au niveau du projet avec une 
balise d'état facultative pour surveiller la progression et les résultats du retrait.

• Remontage de la carte SD: associée à l'action Retrait sécurisé de la carte SD, l'action 
Remontage de la carte SD élimine la nécessité de retirer ou de réinsérer physiquement la 
carte SD. Dans certains cas, elle peut également déverrouiller une carte SD verrouillée et 
vous permettre de continuer à travailler sans redémarrer.

• Prise en charge EXT4: vous pouvez désormais formater les cartes SD et les périphériques 
DOK en EXT4 directement à partir du système. EXT4 offre une meilleure résilience contre 
les pannes de courant, réduisant ainsi le risque de corruption des données par rapport à 
FAT32. Windows ne peut pas formater le système de fichiers EXT4.

• Note:

- vous devez redémarrer le système après le formatage pour que les modifications 
prennent effet.

- Assurez-vous qu'un seul DOK est connecté pendant le formatage.

Enregistrement des 
actifs UniCloud

Vous pouvez désormais enregistrer des API, créer des actifs par asset et activer la 
communication UniCloud directement depuis UniLogic.

• Nouvelle connectivité UniCloud pour API : enregistrer un API, créer et 
activer un actif par asset, activer/désactiver l'accès à distance et 
démarrer/arrêter la transmission de données.

• Liste de contrôle de l'intégration : accédez à la configuration des balises, 
des alarmes, de l'accès à distance et de la sauvegarde des données 
(marquée d'une coche             lorsqu'elle est terminée) et vérifiez-la.
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• Amélioration de la sécurité: l'option « Sélectionner le type d'actif » est désactivée si un 
type d'actif existe déjà dans le projet afin d'éviter toute modification accidentelle.

Alarmes Les alarmes prennent désormais en charge plusieurs nouvelles fonctionnalités :

• Structure des alarmes :

o Les nouvelles balises globales vous permettent de suivre le nombre total d'alarmes 

en attente de réinitialisation, d'acquittement ou de consultation, ainsi qu'un 

indicateur signalant si des alarmes sont en attente.

o Les nouvelles balises de groupe vous permettent d'inclure un tableau pour suivre le 

nombre d'alarmes actives pour chaque groupe, ainsi que des tableaux pour les 

alarmes en attente de réinitialisation, d'acquittement et de visualisation, organisés 

par groupe. Chaque tableau aura une taille de 32 pour accueillir tous lesgroupes. 

De plus, il comportera un champ de bits indiquant si des alarmes d'un groupe sont 

en attente (réinitialisation, acquittement ou visualisation).

o Fenêtre Propriétés : Limites d’alarme

Pour réduire l'utilisation de la mémoire RAM du panneau et d'améliorer les performances, les 

valeurs par défaut de la configuration des alarmes ont été modifiées pour limiter le nombre de 

lignes d'alarme dans les widgets Résumé et Historique à un maximum de 32Un message 

d'avertissement de compilation a été introduit pour les projets dans lesquels ces limites 

dépassent 32. La terminologie utilisée dans la fenêtre Propriétés des alarmes a été mise à jour 

afin d'améliorer la clarté :

Ancien Terme Nouveau Terme

Bannière de Notification Indicateur d’alarme

Mode couleur de la bannière Mode couleur de l'indicateur

Couleur de la bannière Couleur de l'indicateur

Emplacement de la bannière Emplacement de l'indicateur

Ces modifications concernent uniquement la terminologie visuelle et n'ont aucune incidence sur 
les fonctionnalités existantes.

Nouvelles options par 
défaut du projet

La dernière mise à jour permet de configurer les options existantes d'un projet en tant que 
paramètres globaux par défaut, ce qui améliore la cohérence et l'efficacité lors de la création de 
nouveaux projets. Ces paramètres sont accessibles sous Projet > Options, ce qui simplifie le 
processus de configuration des nouveaux projets.
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Type de bannière 
(options déroulantes)

Type d'indicateur d'alarme 
(options déroulantes)

• Grande • Icône + bannière

• Petite 

• Aucune 

• Icône uniquement

• Aucune (ni icône ni bannière)

• Visible en veille • Afficher en veille

• Bouton de répétition visible • Afficher le bouton de répétition
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• Généralités - Vous pouvez désormais définir des valeurs par défaut pour le démarrage 
automatique du mode en ligne, l'utilisation du ping pour la détection, l'affichage des 
différences entre les projets, l'activation des fonctions avancées MODBUS, la 
configuration de la couleur du flux d'alimentation et la définition du niveau de zoom initial 
de l'éditeur Ladder.

• HMI/Web Designer - Ajout de la possibilité de configurer les paramètres par défaut pour 
l'ajustement automatique des écrans HMI et des pages web, de définir une couleur 
d'arrière-plan par défaut pour les pages web et de sélectionner un thème par défaut pour 
les nouveaux projets.

• Options d'impression – Vous pouvez désormais définir les tailles d'entrée par défaut des 
balises Ladder avec des options allant de Normal à Extra Extra Large.

• Paramètres régionaux par défaut – Ajout de la possibilité de prédéfinir les délimiteurs 
CSV, les séparateurs de milliers et les symboles décimaux en fonction des préférences 
régionales.

• Paramètres IP par défaut du panneau – De nouveaux paramètres globaux par défaut vous 
permettent de préconfigurer les adresses IP, les masques de sous-réseau et les passerelles 
pour les nouveaux panneaux.

• Serveurs DNS – Vous pouvez désormais définir des serveurs DNS principaux, secondaires 
et tertiaires par défaut.

• DHCP – Une nouvelle option active ou désactive le DHCP par défaut pour l'attribution 
automatique d'adresses IP.

• Paramètres IP par défaut du processeur – Vous pouvez désormais configurer les 
paramètres réseau par défaut du processeur, notamment l'adresse IP, le masque de sous-
réseau, la passerelle et les paramètres TCP keep-alive.

• Mots de passe VNC par défaut – Possibilité désormais de prédéfinir les paramètres 
d'accès VNC, notamment l'activation de VNC, les mots de passe d'accès complet et les 
mots de passe en lecture seule.

• Paramètres proxy – Vous pouvez désormais définir des configurations proxy par défaut, 
notamment « aucun proxy », « proxy système » ou « proxy manuel » avec des champs 
pour le serveur, le port, le nom d'utilisateur et le mot de passe.

• Configuration par défaut des alarmes – Ajout d'un nouveau paramètre global permettant 

de prédéfinir les configurations d'alarme par défaut pour tous les nouveaux projets.

• Journalisation – Vous pouvez désormais activer ou désactiver les téléchargements de 

journaux par défaut afin de rationaliser le dépannage et l'analyse.

Balises globales Trouvez rapidement le type de balise grâce à une liste déroulante avec recherche.
Un filtre insensible à la casse s’affiche dès 7 types disponibles, avec mise en évidence des 
correspondances.
La liste se réinitialise à chaque ouverture pour une sélection simplifiée.

Protégez par mot de 
passe TOUS les

éléments du projet via 
l'Explorateur de 
solutions

Sécurisez l’ensemble du projet en un clic : clic droit sur le projet → Protéger tout → définissez un 
mot de passe. Pour tout déverrouiller : clic droit → Tout déprotéger → entrez le mot de passe.

Nouveaux éléments 
IHM

• Éléments simples : comprend désormais un widget Ellipse, utilisé pour afficher une forme 
elliptique statique.

• Éléments Graphiques/Jauges : comprend désormais un widget Graphique empilé, utilisé 
pour visualiser plusieurs séries de données empilées dans un seul graphique.

• Éléments hérités : un nouveau groupe Legacy a été ajouté. Il inclut des widgets reposant 
sur d’anciennes structures de données et des workflows utilisant un accès mémoire direct 
– tels que les tableaux d’entiers représentant des chaînes ASCII.
Les éléments du groupe Legacy incluent :

a. Widget Chaîne ASCII, utilisé pour afficher du texte à partir d’un tableau d’entiers en 
caractères ASCII.



• Table de données : utilisez la nouvelle option « Tag : édition activée » dans le 

widget Table de données (DT) pour attribuer un tag BIT permettant d’activer ou 

désactiver dynamiquement le bouton Modifier. Celui-ci reste fonctionnel 

uniquement si la table n’est pas en lecture seule.

• Liste déroulante : la nouvelle option « Dynamique » du paramètre Emplacement 

permet d’utiliser des tags de chaîne ou des chaînes constantes dans la liste 

d’options, offrant une plus grande flexibilité pour créer des menus contextuels tout 

en conservant les fonctions de copier/coller et export/import.

Remarque : les listes déroulantes dynamiques ne sont pas prises en charge dans 

les exports serveur web.

• Champ numérique : utilisez la nouvelle propriété Plages pour modifier 

dynamiquement les couleurs d’arrière-plan et de texte en fonction des valeurs de 

tag.
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b. Widget Chaîne ASCII de mot de passe, utilisé pour saisir du texte masqué stocké sous 
forme de valeurs ASCII dans un tableau d’entiers.

Ajouts à l'éditeur IHM

Serveur Web Vous pouvez désormais sécuriser vos applications web API grâce à la prise en charge du protocole 
HTTPS, offrant une meilleure sécurité et une protection renforcée des données lors des 
communications avec le serveur web.

LF : Magasin et non bit Utilisez cette fonction Ladder pour inverser l’état d’un bit d’entrée et stocker sa valeur logique 
inverse (NON) dans un bit de destination.

LF : Code Gray vers 
décimal

Utilisez cette fonction Ladder pour convertir des données reçues en code Gray en leur valeur 
décimale équivalente..

Fonctionnalités supplémentaires

• Annulation de connexion : possibilité d’annuler une tentative de connexion PLC en cours. Un bouton Annuler est
désormais disponible dans la boîte de dialogue Vérification de connexion.

• Mouvement : améliorations des tables CAM et mises à jour système.

• Client FTP : prise en charge du choix du mode de transfert FTP (passif/actif) et définition de ports ou plages de
ports personnalisés pour le mode actif.

• Configuration matérielle : ajout de la configuration du serveur VNC avec contrôle du pointeur visible et saisie
tactile, assurant la compatibilité avec UniCloud.

• Contrôle d’accès utilisateur (UAC) : ajout du contrôle de session amélioré avec déconnexion automatique et
retour à l’écran d’accueil. (Activer « Set Touch bit » dans UniApps > Network > VNC Server > General).

• Rechercher et remplacer : amélioration de la fonction (Ruban > Édition > Rechercher et remplacer ou CTRL+H)
pour permettre des remplacements de types plus flexibles tout en conservant la compatibilité logique. (Vérifiez la
cohérence du programme après remplacement.)

• Message Composer : possibilité d’utiliser des valeurs constantes dans le champ Position de la virgule décimale
pour les variables numériques dans les messages scannés.

• Options > Localisation : ajout de la langue allemande.

• Buffers : prise en charge de buffers jusqu’à 8192 octets (8 Ko).



13

• Les compteurs UID-0808THS prennent désormais en charge le format INT32 (signé), permettant 

un comptage correct dans les deux directions sans dépassement lorsque les impulsions reculent.

Remarque : les projets utilisant des compteurs UID-0808THS avec des modules en version boot 

1.1 ou inférieure ne peuvent pas être mis à jour vers cette version ou une version ultérieure.

Corrections apportées dans cette version

• Pour chaque boucle :

-Copier/coller des éléments Ladder dans une boucle ForEach pouvait créer une variable 

Current Item” dupliquée (ex. Current Item_1) si le type différait, rendant la boucle inutilisable.

-L’utilisation de “Current Item” dans une fonction Copy buffer to tag dans une boucle ForEach
provoquait des erreurs de compilation.

• Contrôle Personnalisé

-UniLogic permettait d'attribuer une balise de paramètre modifiable d'un type différent dans l'IHM par 

rapport au type défini dans le contrôle personnalisé (CC). Remarque : cette correction peut entraîner des 

erreurs de compilation dans les projets existants où le type de balise de paramètre modifiable dans l'IHM ne 

correspond pas au type défini dans le CC. Vous devez vérifier et mettre à jour vos projets en conséquence.

-Lors de l'utilisation d'une boîte de message avec une action Set Bit sur un bouton dans un 

contrôle personnalisé, la boîte de message ne fonctionnait pas correctement si la balise bit était 

transmise en tant que paramètre..

• Widget calendrier : la plage de dates est désormais étendue jusqu’au 31 décembre 2037.

• Serveur FTP : prise en charge des noms d’utilisateur contenant un antislash (“\”).

• Comparaison FTP : dans certains cas, la fonction réussissait mais ne mettait pas à jour la 

variable d’état principale.

• Data Sampler:

- La colonne Sample Time des fichiers CSV utilisait le point (“.”) comme séparateur décimal même 

lorsque la virgule (“,”) était sélectionnée. (Ce paramètre est interne et indépendant du délimiteur CSV 

régional.)

- Les fichiers .usmp actifs n’étaient pas correctement sauvegardés au démarrage, risquant la perte 

de données lors d’une coupure d’alimentation.

• IHM:

- Les champs de mot de passe perdaient parfois leurs propriétés d’authentification (succès/échec) 

après copie entre écrans.

- Copier une jauge linéaire INT32 sur le même écran pouvait générer une erreur de compilation.

- En mode Online, certaines lignes d’IHM disparaissaient.

• Les opérations de copie, collage et repositionnement d’éléments groupés IHM/Web ne 

provoquent plus de désalignement après modification ou téléchargement vers l’API.

• CAN Layer2: le US15 recevait ses propres messages CAN transmis, causant un comportement 

indésirable

• VNC Touch Bit : reste actif pendant la pression d’un bouton et s’éteint uniquement à la relâche.

• Modbus : la fonction Write/Read Multiple Registers avec un esclave série Modbus version 2.0 

causait un chevauchement de données (mauvais affichage des adresses).

• Action globale “Safe Remove SD” : pouvait à tort déclencher un “SD Lock” et effacer le 

contenu de la carte SD.
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• ST Logic : comparaison de valeurs négatives multipliées par une expression (ex. variable x) donnait des 
résultats incorrects.

• Alarm Summary : la colonne d’état d’une case à cocher n’affiche plus de double coche.

• UniLogic : plantage lors de la compilation d’un projet lorsque le module TC8 était connecté via un adaptateur 
E/S dans les projets US15.

• EtherCAT : l’état d’initialisation pouvait renvoyer le code 4 (échec d’initialisation) lorsqu’il y avait plus de 4 
axes combinés (cycliques + virtuels). Une erreur de compilation a été ajoutée pour éviter les échecs à 
l’exécution.

• Client OPC-UA : utilisation incorrecte du nom d’hôte au lieu de l’adresse IP statique dans les certificats, 
provoquant des erreurs "BadHostname".

• CANopen : correction des adresses d’objets pour les paramètres Stopper Torque et Blocking Time dans les 
méthodes de homing.

• PLC : impossibilité d’aller en ligne dans certains cas à cause de suites de chiffrement TLS non prises en 
charge, provoquant des échecs de handshake.

• UniApps – Auto-Sync : échec de la synchronisation de l’heure du PLC dû à un cache API obsolète.

• UID-0808THS : affichage incorrect de la position réelle lors d’un mouvement PTO va-et-vient.

• Tables de données : lorsque l’option “Afficher les noms des membres du tableau” était activée, les noms ne 
s’affichaient pas et le basculement restait sans effet.

• Routeur UCR : échec possible de l’initialisation si le mot de passe contenait des caractères spéciaux ou si le 
modèle était mal identifié.



UniLogic® V 1.40.135 UNISTREAM® OS 1.40.139 July, 2025

This Service Pack provides the new functions and bug fixes listed below.

Note: This version requires you to update your PLC firmware.

New Functions

• UniCloud: now includes a new feature enabling users to programmatically control the Secure Remote Access 

(SRA) functionality directly from Ladder Logic, providing more flexibility and automation options for remote 

access management.

Previously, SRA control was only available through UniApps, limiting when and how users could enable or 

disable remote connections.

The new feature adds two Global Actions; Stop UniCloud SRA and Start UniCloud SRA, that become 

available automatically when UniCloud is enabled in the application, and can be triggered from various UI 

elements and logic conditions.

• MQTT: Subscription Parameters now supports saving parsed JSON results directly to SD file storage.

• REST API: Response Parameters now supports exporting parsed JSON responses directly to SD file storage.

• USL Displays: configuration options now include selection by hardware model for easier setup. Navigate 

to Hardware Configuration>Controller Model>Properties Window>VNC Server Resolution to access this 

feature.

Bugs fixed in this patch

• LF: SD File Operations: when using literal strings as file path parameters, the 'Read Line from File on SD' 

Ladder function would fail with status -2.

• Modbus: when changing a Modbus TCP slave IP address through UniApps, the Modbus TCP master would 

freeze despite this configuration change being a supported operation.

• UMD-B5: when selecting torque limit units other than "0.1% Tn" in the UMD-B5 Axis configuration, users 

encountered an issue where attempting to enter values resulted in "NaN" being displayed.

• HMI: when creating rectangles with rounded corners in UniLogic HMI screens, the corner radius settings 

would reset after restarting the application. This issue specifically affected users with UI language settings in 

Polish, Chinese, Czech, Korean, Russian, and Turkish.

• HMI:

-when tag names containing ("\u") were used in Audit values, the HMI Service would fail to start, displaying 

an indefinite hourglass and eventually a black screen.

-when Custom Control names contained quotation marks (") and included HMI elements with actions, the 

PLC would become unresponsive after download, showing an hourglass screen or black display instead of

the expected startup screen.

• RedFish Protocol:

-Incorrect Redfish version returned by Chassis endpoint

-Incorrect Thermal Equipment response body text that used "CoolingUnits" instead of "CDUs"

• Emails: when configured to use port 25 with both Use TLS and StartTLS Support disabled, Sendmail 

incorrectly attempted to send emails using SSL.

• CANbus "Sniffer Filter": in certain cases, struct members or array elements used as tags in CAN sniffer 

configurations were not properly recognized, particularly when defining operational modes with power-up 

values.
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• When certain analog input pairs were configured with mixed signal types (voltage/current), the voltage input 

would read at half its proper range (0-5V instead of 0-10V) and current inputs would display incorrect fixed 

values. May impact TA32 models.

• LF: Set DTI Column Value: when negative index values were passed to DTI column operations, CPU errors 

occurred.

• SMS: in certain cases, when sending SMS messages with string variables in the message body, the first digit 

of the variable was incorrectly appended to the destination phone number, causing messages to be 

delivered to wrong recipients.

• Export Project File: entering a valid serial number under “Allowed PLCs” during project export or download

file creation would result in the value not being saved.

• Ethernet/IP: Structured-Text compilation error when referencing EIP structs with consecutive underscores.

• Retained tags' initial values not loaded when importing applications via USB DOK.

Change Summaries for Previous Versions begin on the following page.



UniLogic® V 1.40.103 UNISTREAM® OS 1.40.112 March, 2025

This Service Pack provides the new functions and bug fixes listed below.

Note: This version requires you to update your PLC firmware.

New Functions

• Redfish: now includes significant enhancements to the Redfish Protocol, the new Control Object brings 
control capabilities that were previously unavailable in the protocol, including the ability to connect sensors, 
define allowable values, associate with multiple sensors, and link to related system components. The update 
introduces robust control mechanisms for cooling systems, including start/stop functionality, parameter 
adjustments, and mode selection.

• Load Config .INI:
-now enables setting the 'PLC Name', allowing machine differentiation without sharing the UniApps 
password.

-now enables setting the 'CANbus baud rate', allowing configuration without accessing UniApps for 

enhanced cyber-security.

• REST API: now enables configuring custom HTTP Headers. This enhancement supports projects that require 
custom headers to be set by the user.

• IO-Link: now supports 2 New Digital Hubs
ULK-1616N-M2P6 - IO-Link HUB, 16 I/O ,NPN, M12, IP67
ULK-0808N-M8P6 - IO-Link HUB, 8 I/O, NPN, M8, IP67

• Web Page Password Box Elements: now include the Actions property.

Bugs fixed in this patch

• IP Settings Edit HMI Widget: UniLogic would crash when 'IP Address Type' was set to CPU or DNS.

• In certain cases, SQL queries crash, and I/O Bus errors occur after a PLC upgrade, requiring system reboots.

• Resolved an issue where the 8th input module on a Remote IO URB-TCP was not read correctly and 
sometimes showed incorrect high-state bits for modules 7 and above.

• LF: Bits to Num: Bits in the resulting number were not reset properly.

• Web Server denied access when a favicon was unintentionally used in the application.

• RestManager authorization using a token from a tag failed, resulting in the tag not being registered and 
returning an empty value.

• HMI Rectangle: widgets with a black border were not displayed correctly. Additionally, white rectangles 
were not visible on the screen.

• The alarm banner appeared even when the Banner Type was set to 'Small'.

• In certain cases, the 'FTP Put' command would fail silently when the command length exceeded 256 
characters, showing a successful status despite not actually writing files to the FTP server.

• When importing EDS files in UniLogic V 1.33 and beyond, input and output variables are incorrectly imported 
as bit-type format instead of the expected INT format.

• TCP server on US15 PLCs rejects new client connection attempts following client disconnection events.

Change Summaries for Previous Versions begin on the following page.

17



18

UniLogic® V 1.40.71 UNISTREAM® OS 1.40.91 January, 2025

UniLogic 1.40.71 introduces performance enhancement: Improved download time. After the initial compilation, 

subsequent downloads are now completed faster compared to previous versions. This upgrade reduces 

development time and increases productivity.

This version supports the UAC: Audit feature to ensure compliance with FDA 21 CFR Part 11, supporting secure and 

traceable record-keeping.

Improved Download Time After the initial compilation, downloads are now completed faster compared to previous 
versions. This upgrade reduces development time and increases productivity.

Note that:

• Older UniLogic versions (previous to 1.40.xx), will not be able to communicate with 
controllers running firmware OS 1.40.xx and higher.

• Attempting to download to a controller running older firmware will raise a warning, 
informing the user that the download cannot be completed until the firmware is 
updated.

• If the PLC is running firmware version 1.40.xx or higher, UniLogic versions earlier 
than 1.40.xx will be unable to communicate with it. As a result, downgrading the 
firmware using UniLogic 1.39.xx is not possible. In such cases, use a USB stick as 
explained in the UniLogic Help topic Firmware>How to Downgrade Firmware.

UAC: Audit The new Audit feature is especially needed for ensuring compliance with FDA 21 CFR Part 
11, supporting secure and traceable record-keeping. This feature logs system events and 
user actions across various elements, including:

• User Access control (UAC): Tracks login, logout, and authentication changes.

• Date & Time: Logs changes to date and time.

• VNC: Records remote connection and disconnection events.

• Alarms: Captures alarm acknowledgments and clear actions.

• Actions: Monitors global and local actions, such as tag modifications and bit 
operations.

• HMI: Tracks interactions with elements like buttons, sliders, and data tables.

The feature also introduces a Global Action: Export Audit Trail, which generates digitally 
signed CSV reports using user-defined separators. This ensures data integrity, traceability, 
and compliance with regulatory requirements.

Project-level Actions Actions now include the ability to Load Last Screen.

Third-party Protocol 
Functions

New Ladder function for Build Message Indirect provides dynamic message selection.
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MQTT Subscription Configurations now support parsing nested JSON objects using the
new Complex JSON format, including the ability to capture entire JSON structures with 

the BUFFER parameter.

HMI Editor Additions • HMI Numeric Elements: now includes a Password Numeric Box

• HMI Graphs/Meters: now includes a Dynamic Linear Gauge, enabling dynamic 
changes to widget properties.

• HMI Digital Date and Digital Time: now include additional format options

• HMI Rectangle Elements: now include the Actions property

• HMI Numeric Box Elements: now include Linearization options

WE: Web Page Widgets • WE Text Elements: now support Password Box widgets.

• WE Simple Elements: now includes an Ellipse element

Alarms Alarms now support several new features:

• Global:

o Default Summary Sorting

o Suppress All Alarms

• Each Alarm now includes:

o Log To History - by unchecking this option, you decide which Alarm events 
should not be recorded in the Alarm Log folder on the controller's SD card and 
displayed in the Alarm History widget.

• New Alarm Ladder Elements:

o ACK / ACK & CLR Alarms

AOI: Detect Color Ladder 
Elements

Use the Detect Color from Image and Detect Color from Camera Ladder functions to enable 
optional noise filtering and Region of Interest (ROI) settings, with LAB color space facilitating 
precise color difference calculations using Delta E.

LF: SD File Functions SNMP: You can now use the *.ini file to change the destination IP Address of an SNMP Trap.

LF: Toggle Bit Use this Ladder function to toggle a specific bit's state within an array of bits whenever a 
designated condition is met.

LF: Num to String Use this Ladder function to convert a number into a formatted string.

LF: Buffer Tools Use the Copy Buffer to Array and Copy Array part to Buffer Ladder functions to streamline 
data handling by efficiently transferring information between buffers and arrays.

Reset UniLogic Connection You can now reset the Server via UniApps> System> Control> Reset> Reset UniLogic 
Connection.

Message Composer You can now configure a Checksum Only option in the Message Composer Group Properties, 
enabling the use of a checksum without requiring an ETX character, enabling compatibility 
with devices that use only a CRC16 checksum for message termination.



Additional Features

• Emails: the list of configurable elements in an email now includes Line Break Type, allowing you to 

customize line-break formats for better compatibility across various systems and platforms when composing 

emails in Outlook. Options available:

- LF: for Unix/Mac OS X systems

- CR: for Mac OS systems (pre-X)

- CRLF: for Windows

• HMI & Web Server Rectangle Elements now enable you to adjust the Corner Radius.

• Passwords: to ensure the password stored in the exported file is applied to the controller during application 

import, select the new Overwrite Import/Export App password option under Project>Downloads>Export 

project and firmware to a File>Passwords.

• SPA Track: the Solar Position struct now includes 3 additional Output parameters: Sunrise Hour, Sunset Hour 

and Hour Angle.

• Save As Enhancement: the "Save As" function now defaults to the folder where the current project was 

opened, rather than the last accessed folder.

• CANopen: FunctionIN tags are now supported for the "F" ear (Input Buffer) and used in the SDO Download 

function block.

Note that the SDO Upload function block remains limited to Global tags.

• MODBUS: UniLogic now includes the ability to Import Slaves in the Protocols>MODBUS>Slaves section.

• System > Panel Events Struct: a new read-only status bit, Screen Saver On, has been added. This bit indicates 

when the system is in screen-saver mode.

• Options > Localization: this version contains Korean language localization.

• Touchprobe functionality is now available for the E3 servo drives.

Bugs Fixed in this version

• Unnecessary pop-up messages appeared on every power-up when using a USB keyboard/mouse/HID device, 

incorrectly indicating device malfunction.

• When using the Divide function block on a UINT32 tag, the result is incorrect for values greater than 

2,147,483,647, which is the midpoint of the UINT32 value range.

• When activating the Hardware via Online mode with a working connection, a connection error message is 

displayed even though the activation is successful.

• DataTable HMI Widget: in a Read-Only Data Table widget, the "Enter Array On" button incorrectly appeared, 

despite no array being defined and no editing being allowed.

• Modbus: the SWAP Bytes operation is now restricted to appropriate data types.

• CANopen: resolved a crash occurring in certain high-load CANopen drive applications.

• Alarms:

- the change detection mechanism failed to identify changes to the 'Show suppressed alarms' property,
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incorrectly indicating no differences between the project and the PLC.

- the alarm banner reappeared in full size after using the snooze button and switching HMI pages.

• UAC: failed HMI logins displayed an error but did not allow retry or cancellation.

• LF: Shift and Rotate:

- Incorrect byte-based calculations caused Shift Left/Right function to return an Errno for lengths exceeding 8 

bits. Bit arrays were unaffected.

- Rotate Right function always set the Carry bit to zero when used with bit arrays. Rotate Left function was 

unaffected.

• LF: Linearization: INT32 inputs failed to overflow correctly and produced inaccurate results for large 

numbers.

• Cyclic Live Trend: UniLogic would crash when a Cyclic Live Trend with curves is copied and pasted multiple 

times on the HMI.

• Redfish: when disabling Redfish and saving the project, the user could not re-open the project.

• Message Composer: REAL numbers are missing when sending TCP messages via the server TX command on 

the Built-in models.

• "Data entry complete":

- tag of an HMI element Numeric Box did not trigger when a value of "0" was entered.

- bit for a Numeric Value Box (REAL number type) only triggered for non-integer inputs (e.g., 11.2) but not 

for whole numbers (e.g., 11 or 11.00).

- Find in Array FB did not work when using an array for the data entry completed event in an HMI widget.

• Capture Image: the "PeriodicTaskManager" would crash during project download/import if there was no 

camera connected. This would prevent the camera from functioning until the system reboots.

• REST API: assigning REST 'Response/Query Parameters' tags over 1024 bytes caused REST services to fail.

• Quick Sync: when using the 'Sync' button to download tag changes, images and other elements would 

disappear from the HMI.

• EtherCAT:

- UniLogic would crash when importing the 'Keyence.xml' definition file from the EtherCAT Slaves Library.

- Initialization Status may return status 3, Topology Mismatch, after changing cyclic drive type.

- Updating the EtherCat module firmware must be done with a USB stick, max USB partition capacity: 16GB.

• Online Mode: Local function tag values were not displayed in the grid during online Ladder function 

monitoring.

• Uni-I/O modules: I/O bus error [Code 0] triggered, when connecting a UAG-CX-XKP module on the Built-in 

US15 controller.

• UniApps, Auto-Sync RTC: in certain cases, the Auto-Sync feature failed due to a malfunctioning worldtimeapi 

API, causing the "Sync Now" button to become unresponsive and require a system reboot to update the 

time.

• VNC Server: in certain cases, due to reverse DNS lookups, VNC clients experienced a few seconds delay when 

connecting to the UniStream VNC server.
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• Custom Controls: in certain cases, using the increment action on a tag passed indirectly (e.g., via a Writable 

Parameter) concatenated the value instead of increment it (e.g., 1 became 11). Direct writes were 

unaffected.

Change Summaries for Previous Versions begin on the following page.
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UniLogic® V 1.39.103 UNISTREAM® OS 1. 38.55 December, 2024

UniLogic 1.39.103 introduces: Redfish-embedded PLCs. Natively supported by Built-in controllers only, the Redfish 

RESTful interface API enables UniStream to control data center cooling. This version also launches the new 

UniStream US15-B10-B1, a powerful PLC + HMI with a big, quick-response 15.6” touchscreen, additional features and 

bug fixes.

Redfish: Data Center

Cooling

Redfish is a RESTful interface API based on a JSON data format, designed for data center

management.

New

UniStream Built-in 

US15-B10-B1

The new US15-B10-B1 PLC + HMI Built-in offers:

• Enhanced Performance: a significant boost in processing power.

• Faster Real-Time Task Execution

• 15.6” Touchscreen HMI

• No Built-In I/Os—Create the configuration that exactly meets your requirements: 
snap on Uni-IO to create an on-board configuration, and expand remotely with Uni- 
IO, Ethernet Remote I/O, EtherCAT, and IO-Link modules.

• EtherCAT Compatibility: The US15-B10-B1 is the first UniStream Built-in model to 
support our EtherCAT master module—and discrete, multi-axis EtherCAT motion.

Online Test Mode:

Increased 

Functionality

• Alarms: you can now click an Alarm, and view all of its properties. Note that the 
properties are view-only.

• HMI Widgets: you can now click an HMI widget, and view all of its properties, 
including any assigned Actions. Note that the properties are view-only.

AOI: Get RGB

Ladder Element

Use this function for identifying the RGB (color distributions), in various objects.

LF: SPA Track The Solar Position Algorithm (SPA) Ladder function enables UniStream to direct solar panels

at the sun all day long for maximum exposure.

LF: Modify Alarm

Property

Use this Ladder function to modify an Alarm’s description.

LF: Digital Signature

Sign

This LF enables you to digitally sign SD generated user log files.



Additional Features

• IO-Link: in the Master's Properties window, you can now set the Pin2 Safe State.

• USB Action files can now be set to require a user password.

• LF: SD File Functions: You can now use the *.ini file to change the IP address of a URB Remote Ethernet I/O in 
your project.

• User Access Control: In UAC properties, you can now select:
- Text input to cause the user to type in the user name.
- Drop down, to allow the user to select the user name from a list.

• OPC UA: You can now rearrange tags by hovering your cursor in the left column to reveal the hamburger 
menu and dragging the tag to a new location.

• SD Management: You can now save captured images in the following SD card folders:
- “/SD/Media/Camera”
- “/SD/Media/Camera/AOI”

Bugs Fixed in this version

• PTO:
- PTO would crash when a move of one pulse was requested.
- In certain cases, requesting Immediate Stop would behave inconsistently.

• Calendar Date, HMI widget: selecting a Day of Week via the HMI did not update the Day of Week tag in the 
RTC struct.

• VFD Write Raw Modbus: CPU would crash when using this Ladder Function.

• Telegram:
- when building a message, the user could not include read-only tags, the user can now include both read- 
only and writable tags.
- within messages, UniLogic identified tags that were linked to parameters as 'unused tags'.
- UniLogic did not correctly include the values of string ASCII tags.
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UniLogic® V 1.38.64 UNISTREAM® OS 1. 38.68 August, 2024

Service Pack 1 for UniLogic, 1.38.64

This Service Pack provides the fixes listed below.

Bugs fixed in this patch

• CPU OS 1.38.29 (included in BIN 1.32.68), caused the On-Board temperature input to return 

incorrect values.

• BIN version 1.32.68 caused the screensaver to behave unexpectedly.

• Library import might fail due to Timer usage.

UniLogic, 1.38.62 supports a new series of Servo drives and Motors. The new B5 & E5-S* Servo Series 

expands your Motion potential with a wider power range of up to 7.5kW (10 hp), common DC bus, 

enhanced tuning, built-in STO (Safe Torque Off), TouchProbe functions supported by new PLCOpen MC 

Function blocks, and more.

New Servos, Motors, MC Functions UMD-B5 and UMD-E5-S servo drives and motors 

are now available in Hardware Configuration.

These models offer Touchprobe functionality, 
supported by two new FBs:

• MC TouchProbe
Use this to record an axis position at a
trigger event. It records an axis position 

at the point in time of a digital signal 

(measuring probe function).

• MC AbortTrigger
This Function Block interrupts a 

measuring probe cycle initiated by 

MC_TouchProbe

Servos: Modulo Axes You can now define Modulo Axes for 

both EtherCAT and CANopen

Cyclic 'Live' Trend Cyclic Trends enable you to display a specific 

time frame of a running variable integer value, 

for example, the last 10 seconds, as a curve on a 

Trend graph.

The values are not drawn from a Data Sampler, 

and Cyclic Trends do not store any values, log 

any data, or create any files.

DataTable HMI Widget Data Table Properties of Appearance now provide 

a new option, Scroll Bar Width.

Additional Functions

Enhanced security for Numeric Boxes in both HMI Elements (HE) and in the Web Page Editor. Use the 

new 'Mask Entry' checkbox in UniLogic to enable this feature.

New Help Topics

• Shift-Rotate functions now have expanded Help topics.

• String functions and Array functions are now fully documented.

• The Schedule Ladder Function topic has been improved.
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Bugs Fixed in this version

• UID-0808THS: Stop request during PTO acceleration or deceleration would cause the PTO to 

freeze, THS OS 10.10.

• UID-0808THS: PTO maximum speed was not updated according to units ratio, THS OS 10.10.

• OnBoard IO: Overflow on 14-bit analog inputs in the OnBoard IO wasn't detected, depending on 

production calibration. May impact RA28, TA30 and TA32.

• ST Bitwise AND & OR operations are not functioning correctly.

• UID-0808THS - Scenario 3 queue mode fails on frequencies 50KHz and higher.

• "Data entry complete" tag of an HMI element Numeric Box sometimes changes in state is not 

immediate.

• Pressing Reset Display when using a USB keyboard/mouse/HID device, might cause the screen 

to turn black.
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UniLogic® V 1.37.79 UNISTREAM® OS 1. 37.79 June, 2024

Service Pack 1 for UniLogic, 1.37.79 provides the fixes listed below.

Note: this version requires you to update your PLC firmware.

Bugs fixed in this patch

• Data Tables:

- Entering Online Mode when working with a Data Table would cause Online Mode to terminate
- Dragging (undocking) a Data Table would cause UniLogic to freeze, requiring the user to close 

and reopen UniLogic.

• Printing: when a project was printed to .pdf, the Structured Text functions were not included.

• Screen Saver: continued to run when turned off from UniApps.

• Camera Capture: width and height tags are optional; however no image would be captured if 

these tags were left undefined.

• SD Management: selecting to clear the Camera folder did not remove AOI debug files.

• UCR Routers; name error: UCR Routers delivered after June 1st, 2024, require this version of 

UniLogic (Service Pack 1 to 1.37.00) or later.

Also included in this release: MODBUS>Advanced Properties Window: Float Type has been renamed to

4-Byte Swap Type.

UniLogic, 1.37.00 supports a new series of Servo drives and Motors.

The new B5 & E5-S* Servo Series expands your Motion potential with a wider power range up to

7.5kW (10 hp), common DC bus, enhanced tuning, built-in STO (Safe Torque Off), TouchProbe 

functions supported by new PLCOpen MC Function blocks, and more.

*E5-S EtherCAT drives are coming soon.

New Servos, 

Motors, MC 

Functions

UMD-B5* and UMD-E5-S servo drives and motors are now available in Hardware 

Configuration. These models offer Touchprobe functionality, supported by two new 

FBs:

• MC TouchProbe
Use this to record an axis position at a trigger event. It records an axis 

position at the point in time of a digital signal (measuring probe function).

• MC AbortTrigger
This Function Block interrupts a measuring probe cycle initiated by 

MC_TouchProbe

*The current version of the diagnostic application does not support the B5 series

Servos: Modulo 

Axes
You can now define Modulo Axes for both EtherCAT and CANopen

DataTable 

HMI Widget

• Data Table Properties of Appearance now provide a new option, Scroll Bar 

Width.

• The HMI DataTable widget UAC configuration now offers Element 

Restrictions, which offers an Invisible option; when enabled, the widget will 

appear only to users who log in with the correct user level. Note that you 

must enable User Access in order to reveal the Invisible option.
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UniApps • Open Menu: by default, to open UniApps, the end-user must touch and 

maintain contact for several seconds with the upper right corner of the HMI 

Panel touchscreen until the UniApps sidebar menu appears. You can now 

change the location of the point of contact in Hardware 

Configuration>Controller Model>Properties Window>UniApps Side by Side 

menu.

• User Access Control: the interface has been improved; when adding users, 

only the groups and users that are used in the project, and that have 

assigned roles, are now shown.

Live Trend The number of curves for a single Live Trend graph has been raised from 4 to 8

UniCloud Data 

Backup

If you have a UniCloud subscription from Basic Data subscription or greater, you 

can backup data stored on your controller's SD to the cloud. The data is stored in 

the cloud in a .zip file, and can be downloaded, or restored from UniCloud back to 

the PLC.

USL Displays In UniApps, you can now connect via hostname, as well as IP address, by 

accessing UniApps Network>General IP/Hostname, and selecting Hostname.

HMI Widgets Circular Gauge widgets now offer the option Whole Circle; selecting this option 

results in the gauge numbers and ticks covering the entire 360 degrees of gauge.

Project-level 

Actions
Actions now include the ability to actviate and deactivate the Screen Saver

TextBox widget The numeric keyboard now offers commas and dots

Bugs Fixed in this version

• Load Config from INI: when done from DOK, was not supported by the USC-B3 models.

• REST_API: Minor changes might result in 'Download All with Reset' when it was not necessary.

• BACnet: "Access Denied" error would result when trying to write to Binary Value.

• Servo Ladder Functions: Loading a Servo configuration after Storing it would result in 

Configuration Mismatch Error (-5 ).

• UniApps Timzone: setting timezone from UniApps did not update the localtime file with the new 

timezone link.

• "Set value" HMI Action took excessesive time (~1s-2s).

• Live Trend Widget, Web Server: "Curves" button did not work.

• UniStream UAC: User names were case-sensitive, and allowed duplicate usernames.

• Router INIT Ladder function would fail (-9 ) when there was no SIM card installed.

• The option to change the Open UniApps side menu location was visible, but did not take effect.

• C Functions:
-Global variable tag values did not change on nested C function calls
-If a Global tag was used in a FunctionOut call, the value did not update

• Asset Type: UniLogic would crash after refreshing an Asset Type, if a Demo Asset Typewas 

selected.

• UAC struct: if a user was changed to different group via UniApps, the "comment" in the UAC 

struct did not update the name of the changed group.

• Load Certificate Status: the Error PopUp did not in the correct format.

• THS: PTO Move would stop running after a period of time.

• Call Function: the hyperlink to calling function was missing, if the called function was type C or 

ST.

• 0808THS module: Counter+scenario 3 encoder A/B did not function properly.
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UniLogic® V 1.36.44 UNISTREAM® OS 1.36.44.xx March, 2024

This version of UniLogic supports the new B7 VFD series that supports EtherNet and provides closed- 

loop control, a new analog IO-Link hub, the ULK-0808AIO-M2P6, Telegram messaging, and more.

VFD:
New Series

VFD B7 is the successor to the B5 series, bringing you motor control for torque, 

speed, and boosts safety with built-in STO. These expandable inverters offer advanced 

motor control with features typically found in specialized drive solutions.

Optional: Ethernet communication, I/O, and closed-loop encoder cards.

IO-Link: New 

Analog Hub

The new analog IO-Link hub, ULK-0808AIO-M2P6, provides 8 input/output channels 

that can be set to either current or voltage.

Telegram UniStream controllers now support Telegram messaging via UCR router. Integrating 

Telegram support into your machine can offer several advantages:

• Real-time monitoring and machine control via Telegram's fast messaging 

service

• Automation: for example, in your UniLogic project, you can build a program 

that sends alerts or reports about machine performance to a Telegram BOT.

• Security: Telegram messages are highly encrypted, which can aid in protecting 

sensitive machine data.

• Multi-platform Access: Telegram allows you to access your chats from multiple 

devices--from any location.

• Free of Charge: Since Telegram is free for unlimited use, it is a cost-effective 

solution.

• Team communication: the ability to create groups or channels in Telegram can 

aid in various ways, including support.

Additional Features

Change VNC 

Password

You can now use a Ladder function block to change the VNC Server Password and 

Management Level.

VFD: Read/Write 

Direct

New Ladder Elements, VFD Read Raw Modbus and VFD Write Raw Modbus enable you 

to directly read and write to a VFD.

HMI Element: 

Slider

A new property has been added, Preserve Margins. This is checked by default; 

uncheck if you wish to decrease the padding around the slider.

Bugs Fixed

• B1 VFD models: in certain cases where the rated voltage was changed, the configuration was 

not saved.

• Digital Time HMI Element: behavior was Read-Only without regard to the actual setting.

• IO-Link:
-The IODD parser would incorrectly set the master's port configuration value.
-Adding 4 device IIOD's toone IO-Link master wouldcause compilation error.

file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VFD_-_Variable_Frequency_Drives.htm%23Configuring_Ethernet_(Modbus_TCP)_VFDs
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VFD_-_Variable_Frequency_Drives.htm%23Configuring_Ethernet_(Modbus_TCP)_VFDs
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/Telegram_-_via_UCR_only.htm
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_136_2024/contents/VNC_Server_Management.htm%23Configure_VNC_Server_via_Ladder


30

• WebServer password protection: if protection was removed and project then saved and closed, 

when reopened the webserver in the project would still be password-protected.

• Application Download: after upgrading from BIN 1.32.112 to BIN 1.35.47, users could not 

download a UniLogic application to the controller.

• HMI Action - Set Value: if a HEX value was given, the specific action was not applied, and other 

actions were ignored as well.

• Servos: Drives would not recover communication after a power outage.



UniLogic® Service Pack UNILOGIC® V 1.35. 227.92 UNISTREAM® OS

1.34.47 December, 2023

This version of UniLogic, released in January 2024, provides security enhancements to protect 

networked controllers from cybersecurity threats.

(Special thanks to Noam Moshe of Claroty Research - Team82.)

Note that the Equipment Level cybersecurity measures described in the Unitronics’ 

document hosted on our website, ‘Unitronics Cybersecurity for UniStream PLC Series’ are 

now mandatory.

In addition, the Network Level protection measures described in that document, including 

using a VPN to secure communications and protect equipment, are strongly 

recommended. Implementing Network Level protection is the responsibility of the user.

This version of UniLogic requires you to change the default PLC communication password
and to implement complex password. In addition, this version requires you to implement 

a VNC password.

Unitronics strongly recommends that users with existing applications comprising 

networked UniStream controllers update to the current version.

Security Features

PLC Password As of this version, UniLogic requires you to change the default PLC 

communication password, and requires you to assign a complex password the 

first time you establish UniLogic to UniStream communications to a particular 

PLC, for example at application download, or to run online Test mode.

The PLC password must be at least 8 characters long and must contain at 

least 1 digit, lower case letter, and upper case letter, in addition to at least 1 

symbol.

Once a password is assigned to the PLC, UniLogic stores that password for 

that specific user (the user currently logged into Windows).

When any user attempts UniLogic to UniStream communications, UniLogic 

authenticates the user access permission to that specific PLC.

VNC Password As of this version, enabling VNC requires you to create a strong password. The 

option to enable VNC without a password has been disabled.

Addtional Feature

2 VFDs via 

RS485

Relevant for Built-in and UniStream PLCs, not UniStream Modular. 

You can now add 2 serial RS485 Add-on Ports to your hardware 

configurations, and define the port of each to VFD.

Bugs Fixed

• IO-Link:
- RPI (Requested Packet Interval) was linked to the total number of linked devices, when should 
be linked to the total number of masters.
- IODD files were sometimes incorrectly parsed

• Modbus Slave IP: in certain cases, updating a slave IP manually or via TCP did not write 

the new address to the Modbus slave.
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•

• VNC Client, UniApps: the cursor was visible when Disable Cursor was turned ON.

AOI, compilation errors: in certain circumstances, AOI rectangle coordinates were not

assigned to the correct struct tags.

• UniLogic might shut down when a project was saved as 'Save As', reopened, and a 

module (HMI. Ladder, Web) was added.

• Web-server:
- Copy&Paste of of Numeric Box and Timer Box into a web page would cause UniLogic to shut 
down at compliation.
- Numeric values were sometimes incorrectly displayed with thousands separators.
- Numeric box: configuring Language> Regional Settingsa to show a thousands separator would 
show the separator in UniLogic, but the number would be displayed without the separator.
- Numeric box: values configured as normal text would appear as bold text.
- After editing, Web pages would sometimes appear with incorrectly-sized fonts, incorrect 

background colors, and incorrectly-underlined values.

• Quick Sync mode, Online: a project is verified before entering Online mode. For this 

reason, Quick Sync no longer reestablishes connection and re-verifies project.

• HMI Timer box: 'Text Before' would not be displayed if 'Text After' was not configured as 

well.

• Structured Text: using 'TO_ REAL' inside a FOR Loop would cause a compilation error.

• Set DTI Column Value inside a ForEach loop causes compilation error.

• Load Config from INI: did not allow a remote URL to be set for the FTP client.

• C functions: creating a C function, upgrading the UniLogic version, and adding additional 

lines of code caused compilation errors.

• EDS files:Ethernet IP Structs with INT arrays did not load correctly in Unilogic 1.34.192.

• Changing COM port settings from UniApps: if the port was set to Modbus, the change did 

not take effect.

• SFTP client: PLCs failed to send files via SFTP when the password contained an ' 

(apostrophe).
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UniLogic® Service Pack UNILOGIC® V 1.34.92 UNISTREAM® OS 1.34.78 

October, 2023

The UniLogic version, released in October 2023 brings you the features and bug fixes listed below. Powerful new 
features include support for both IO Link masters and devices, Structured text, AOI, the ability to open and run up to 
3 instances of UniLogic, and more.

This UniLogic version, released in October brings you the features and bug fixes listed below.

Powerful new features include support for both IO Link masters and devices, Structured text, AOI, the 

ability to open and run up to 3 instances of UniLogic, and more.

New Features

IO-Link UniStream controllers now support IO Link.

All UniStream controllers support the new Unitronics IO-Link Master products. 

Specific models of masters and modules as well as cables are available from 

Unitronics; these models are visible in UniLogic's Hardware Configuration.

In addition to the specific IO-Link modules offered by Unitronics, you can
include other IO-Link devices and import the device's IODD (IO Device 

Description) that is supplied by the device manufacturer.

Structured Text UniLogic now offers a Structured Text editor, along with library of functions 

such as MAX MIN, LOG, EXP, Trig functions and more.

You can build Structured Text functions and use them in the same way you 

use standard ladder or C functions. You can call them just like standard ladder 

functions, reuse them, and export/import them via the Library. You can

also refer to Ladder functions.

Structured Text:

• Enables text-based development, that is compact and easy to read
• Is highly portable--and allows you to copy developed functions from 

other brands

• Allows easy comparison and source control

AOI
(Automatic Optical 
Inspection)

New Compare Image Ladder functions now enable you to compare:

• Images from a connected USB Camera to an image stored on the 

controller's SD card

• Two images stored on the controller's SD card

You can select the algorithm family and specific algorithm that the function will 

use to compare them. Algorithm families include:

• Pixel-wise Comparison

• Histogram Comparison

• Template matching

• Feature Detection and Matching

UniLogic: Multiple 

Instances
You can now open and run up to three UniLogic projects at the same time to 

compare them. You can also transport the following elements between them:
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• Drag & Drop, or copy & paste Ladder elements and rungs from one 

open UniLogic project to another open project.

• Copy HMI/web page elements, including all of the elements on a 

screen/page, from one open UniLogic project and paste it into to another open 

project.

Note that UniLogic automatically creates tags and structs as needed.

MC Motion 

Functions: Buffer 

Mode

The parameter Buffer Mode has been added to the MC Function Blocks listed 

below. Note that this mode is relevant only for Cyclic or Virtual Axis motion.

• MC GearIn

• MC GearOut

• MC GearInPos

• MC CombineAxes

• MC MoveAbsolute

• MC MoveRelative

• MC CamIn

• MC CombineAxes

Motion: Virtual 

Axis
In Motion > Axis, you now have the option to add a virtual axis.
You can then use it as a virtual machine shaft, master axis, or any other 

intermediate axis for complex relationships between master axes and slave

axes.

Camera Ladder 

Functions
Camera ladder function Capture Image now includes Image Width and Image 

Height parameters.

You can use this feature to capture images of the correct dimensions for AOI.

UniCloud You can now use Asset Type as a template to:

• Allow the share of a defined Asset Type on equipment using 

different types of hardware

• Reuse configured dashboards without the need for using Tag 

Types

REST API XML response support:

• New Content Types: in addition to JSON, UniStream now also 

supports xml, Text/Plain, and x-www-form-urlencoded support

• Requests: you can now select to accept JSON or XML for all request 

types.

JSON Content Parameter Levels: these have been increased from 3 levels 

to 5.

C: Online Mode and 

Global Tags 

Property

You can now:

• Enter OnLine Mode when viewing a C function and view the value of 

individual tags, as well as view all of the struct member values.

• Include global tags in your C code, enabling you to use them via online 

mode, without having to pass them as a parameter.



Quick Sync When in online mode, you can enter Quick Sync Mode then change logic and 

tag assignment.

Router: Get/Set 

IOs

New ladder functions enable your to read from and write to the status of I/Os 

on Unitronics B5 and B8 routers.

Rung comments Double-clicking on the rail now allows you to add/open a rung comment.

Tag Groups You now have the option to group global and timer tags. You can also right- 

click a tag group and rename it; all tags in that group will be automatically 

assigned to the new name.

UniApps in Spanish The UniApps interface now supports Spanish; to display different languages in 

the UniApps interface, select the desired language in Hardware Configuration> 

Controller Model > Regional settings.

Alarms There is now an option in Alarms Banner notifications to link a bit that turns on 

when the end user presses the Snooze button.

LF: Load Config Ini • MODBUS: You can now set ModbusTCP (IP Address,
Port) parameters in your application via the Load Config - .ini ladder 

function.

• Load from DOK: Load Config .ini now allows you to load a file 

from a DOK (USB stick) as well as from an SD card.

Ladder Elements: 

Up Down

Located in the Ladder toolbox under Basic Elements, these Ladder elements 

pass on the RLO of a rung--without being linked to a tag:

• The Up element assigns TRUE to the output signal Out for one 

cycle only when the input signal In changes to TRUE. Otherwise, the 

value of Out is FALSE.

• The Down element assigns TRUE to the output signal Out for 

one task period only when the input signal In changes to FALSE. 

Otherwise, the value of Out is FALSE

PC-PLC Password You can now change the PC-PLC communication password via UniApps> 

System> PLC >System > PLC Password.

Project Password You can now assign a password that will be requested by UniLogic whenever 

anyone attempts to open the project.

WE: Web Page 

Widgets

Web Pages now support Time and Date widgets; configure them the same as 

you do HMI Time and Date widgets

Additional Features

• When the VNC client is attempting to re-establish communications, a popup timer is now 

displayed, counting down the remaining time until retry.

• Modbus Slave IP addresses are now automatically updated when the IP address is 

changed via UniApps, a Load.ini file, via USBF, or via DHCP.

• C Editor: the status bar at the bottom now indicates both the line and the column 

location of the cursor.

35

file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Tags/Tags_(Operands).htm%23Tag_Groups
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Tags/Tags_(Operands).htm%23Tag_Groups
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Tags/Tags_(Operands).htm%23Tag_Groups
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Tags/Tags_(Operands).htm%23Tag_Groups
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Tags/Tags_(Operands).htm%23Tag_Groups


36

• HMI Timers: a new option in the Timer Box allows you to enter any text you wish to set 

as a prefix to the numeral. You can also include special characters, such as a degree sign, by 

clicking the button on the right of the Text Before field.

• HMI/Web Numeric Box: you can now add a prefix of text and special characters to 

display in front of a numeric value.

•

• Arrays: you can now create arrays of up to 1024 elements.

• You can now export and import Switch Case instances.

HMI Element File Selector: now includes an option to select the Camera Folder from the

controller's SD card.

Bugs fixed in this version

• Polish virtual keyboard: the 'Y' 'Z' keys location were transposed.

• Alarms: modifying alarms from CSV files did not properly update the Alarm Banner, and 

sometimes caused Alarms to crash.

•

• 04PTN: in certain situations, Input 0 would freeze.

Message Composer: did not work properly when numeric tag format setting in the

message is Leading Zeros

• Web Timer Box, Seconds format: value was not displayed correctly

file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Switch_Case.htm
file://///localhost/C:/Users/Cara/OneDrive%20-%20Unitronics/!!!!!!!!!!!!!!!!!!!!!!UniLogic_May_2023/contents/Switch_Case.htm
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UniLogic® Service Pack UNILOGIC® V 1.33.373 UNISTREAM® OS 1.33.280 

June, 2023

This UniLogic release, released in June 2023, includes firmware that supports a redesigned version of 

some UNI-IO models and hardens the Cybersecurity of your applications.

Read on to learn the details, and to see the bug fixes included in this version.

New Features

Cybersecurity This security release hardens the UniLogic to UniStream communication 

mechanism, in order to reduce unauthorized access.

Note that:

• Older UniLogic versions (previous to 1.33.246), will not be able to 

communicate with controllers running firmware OS 1.33.246 and higher.

• Attempting to download to a controller running older firmware will raise a 

warning, informing the user that the download cannot be completed until the 

firmware is updated.

• If, for some reason, a firmware downgrade is required, use a USB stick as 

explained in the UniLogic Help topic Firmware>How to Downgrade Firmware. 

You will not be able to downgrade via UniLogic ribbon >PLC> UniStream 

Management -> Remote Upgrade

In general, for better cybersecurity, we recommend that you always use the 

latest firmware.

Uni-IO:
Firmware 
Update

The firmware included in this release supports all Uni-IO models, modules 

bearing a label containing the following:

• Serial numbers with the characters US1 start from the 3rd position, for 

example: XXUS1ZXXXXX

• Text warning "Unit requires Firmware (BIN) 1.33.246 and up "

Timer Box widget You can now use more than 10 digits in the Keyboard Title property of a Timer 

Box widget.

New System Struct A new System struct has been added, Regional Settings containing ASCII string 

members for CSV Delimiter, Decimal Symbol, and Thousands separator. At 

power-up, or when HMI language is changed, the controller will write the 

current regional settings into the struct.
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Bugs fixed in this version

• Modbus RTU v2.0 did not update the RS485 port struct with TX/RX counters.

• Alarms group import did not preserve the exported alarm IDs.

• Export of alarm group would fail.

• Export screen in UniLogic would sometimes fail.

• Exporting IO tags to Excel would create an empty table.

• DataTable widget, Time format column, min and max limits were not applied.

• Linear gauge: Anchor and Range did not work for negative values.

• Radio button widget: did not work on web pages when Font size was applied.

• REST API GET: did not support an authorization token with special characters.

• UAC: Logged in users were sometimes logged out after download.

UniLogic® Service Pack V 1.33.xx UNISTREAM® OS 1.33.xx MAY, 2023

This UniLogic version, released in May 2023, brings you new features including new HART functions

,DHCP, Motion functionality, and more.

Read on to learn about the new features and bug fixes in this version.

New Features

HART New

Functions

New Ladder functions for Build and Parse HART commands simplify 
implementing HART in your applications.

Motion • EtherCAT Multi-Axis MC functions: a new Ladder element Get Cyclic 

Mode Error Description enables you to load the ASCII description into the 

linked ASCII string tag.

• Motion Status and error codes are now collected into a single topic for 

easier troubleshooting.

• CAM Table Plot: Select a CAM recipe, and from the Recipe tab, select 

Show CAM Table Plot, then use the Configuration tool to adjust the view.

Password- 

Protect via 

Solution 

Explorer

You can now right-click additional items on the Solution Explorer to password- 

protect many parts of your application, for example in Hardware Configuration, 

Communication, Motion, and more. The next time the project is opened, the 

password must be supplied before the item can be edited.

DHCP New options in PLC Communications> Panel IP and UniApps> Network> IP 

Config> Panel DHCP now allows you to enable DHCP and, when DHCP is 

selected, to override DNS server.

UniApps You can now:

• View Logs for events such as download, upgrade, powerup 

in UniApps>System>System Logs> Customer Logs.

• Filter Wireshark communications.
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• You can now see a connected EtherCAT firmware version and 
upgrade it - even if the PLC does not contain an application

• Set a PLC Hostname.

Languages, 

Regional 

Settings

Regional settings for each language are now available via Solution 

Explorer> Languages.

HMI and Web 

page Widgets

• Radio buttons: You can now arrange radio buttons simply by 

entering the number of columns in the widget parameters; UniLogic 

automatically arranges the buttons in Columns.

• Data Table Widget now allows you to:
- Set colors for Odd and Even Rows.
- Set Font Size.

• File Selector: Camera files have now been added to the selection 

list.

• Timers, Minimum/Maximum: you can now set limits for timers.

• Text Boxes: you can now align text boxes in 9 directions.

HMI
Screenshots

In the HMI Editor>HMI tab> Screenshots, you now have the option to export all 

of the screens in your application at once as screenshots.

I/O Module 

UID-0808THS

New Scenario 4, Counter, PWM, PTO enables you to command trapezoidal 

motion at run time via the module struct.

Loops A new Loop Data Block parameter, Is Busy, allows you to know the status of the 

block.

Email: TLS When you configure an email account, a new column, TLS, in the account 

options can be checked to support Transport Layer Security (TLS).

VNC The number of VNC clients that can connect to a PLC has been raised from 8 to 

16; if the connection is via UniCloud, the maximum number of connections is 

limited to 8.

Actions A new action, UAC Log out Request, enables logout as a result of ladder 

condition.

Alarms • New LF: Get Alarm Name - use this Ladder element to get the 

name and description of an Alarm, according to its index number.

• Alarm logs: Previously, the Is Alarm Created bit and the the Last 

Alarm Log Zip Filename were only updated if Create Zip File was 

checked. Now, these parameters are updated even if only XML/CSV files 

are created.

USB serial 

devices

UniStream can now support USB serial devices at a baud rate of 230400 

bits/sec

Please note that you cannot use the Rename File on SD Ladder Function to rename a file that is 

located in the Alarm Log folder. The Help topic has been amended to include this issue.

Bugs fixed in this version
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• WebServer Widgets set to Min/Max linked to constant tags did not work

• Update Application Ladder element did not work with String tag as path

• SMS Receive from Router (UCR) was only 7 words long

• Tags: Could not type non-Latin characters in tag description when creating new tag, 

however Ctrl+V could paste from external source

• REST: Requests with Hard-coded content parameters did not work

• Screen Saver configured to 'Power Off' mode on B10 Modular PLCs did not turn the 

display completely off

• If "MoveSDFileToDOK" on Copy\Move File ladder element failed, the reason (-8 no 

source file) was not displayed

• Changing COM port settings from UniApps did not have an effect if the port was set for 

Modbus

• HMI Schedule widget did not work in Custom Control



UniLogic® Service Pack V 1.33.xx UniStream® OS 1.33.xx, November 2022
REST API • UniLogic now supports REST API GET, POST, PUT, DELETE queries and 

the Authorization methods of No Authorization, Basic

Authorization, OAuth 1.0, OAuth 2.0, and Custom Authorization.

• Content: you can now add JSON members and content to your POST and 

Put queries.

• You can now right-click a REST API request to duplicate it.

USL

Password
You can now apply a password via UniApps that will be saved to the PLC via 

the new System> Password tab.

Export BOM You can now generate a BOM (Bill Of Materials) report that matches the 

Hardware Configuration of your project by selecting the Tool tab on the 

ribbon and clicking Export Project's BOM.

UniApps:

Update
Update App and firmware now allows users to scroll though and select 

desired files.

VNC Server UniStream VNC server "Set Touch Bit" is now checked as default value; this 

allows the screen saver to recover from VNC.

External

Keyboard

The interface for entering Numeric values and Text has been improved for

external keyboards connected to UniStream.

HMI Disable

popups

Via UniApps, users can now choose to ignore specific popup messages by

selecting this on the System Log tab, and selecting the desired popup to 

disable.

Please note that you cannot use the Rename File on SD Ladder Function to rename a file that 

is located in the Alarm Log folder. The Help topic has been amended to include this issue.

Bugs 

• If the SD card was not found, the system would issue an I/O bus error although there would be 

no I/O error.

• In certain cases, the Router status was set to Fail inappropriately.

• Compilation warnings were issued for Alarms when one was not used in the application

• "Screen Power Off" mode on USP-070-B08 did not power off display as expected.

• UniLogic would crashes at compilation after a copy-paste call of a function with a Function-In 

parameter

• In certain applications, HMI screens could not be exported.

• In some cases, certain elements on Custom Controls did not work, or prevented HMI screens to 

load.

• HMI message boxes sometimes blocked HMI actions and buttons.

• Pasted ladder elements with constant inputs would appear invalid.

• Older applications using REST API, did not open with UniLogic 1.33.213

• Images and video from USB camera were not captured.

• Modbus: Success counter of Read operations would continue to increment after slave was 

disconnected.
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• Trends, Web:"History" button on web pages did not work.

• UniLogic did not Download & Reset after REST configuration changes.

• Alarm Logs: the Is Alarm Log created was not set to ON if zip files were not selected.

UniLogic® Service Pack V 1.33.xx UniStream® OS 1.33.xx, September 2022

Major Features

EtherCAT Motion:

Multi-Axes functions

When you use an Unitronics EtherCAT master module and configure
the axes Mode to Cyclic, the master acts as a motion controller, 

generating the motion profile and controlling the drives to enable you 

to implement Multi-Axes functions such as Camming and Gearing.

UniLogic 

Infrastructure

UniLogic versions previous to 1.33 were based on SQL 2012 LocalDB, 

which reached end-of-life and is no longer supported by Microsoft; 

therefore Microsoft will not patch possible security vulnerabilities in 

SQL 2012.

After you install this UniLogic version, all projects of any version that 

are opened and saved on this PC will be automatically structured to 

SQL 2019 LocalDB.

EV Charger (OCPP) 

Support

New Ladder elements now support and enable you to implement 

Electrical Vehicle Chargers Protocol (OCPP v1.6), the protocol is 

available only for UniStream Pro (B10/C10) series models and 

requires a license.

Loops UniLogic now supports the following types of Ladder Logic Loops: For, 

For Each, and While. Users can manage the number of iterations per 

scan.

Update UniStream 

Firmware and 

Application

You can now update UniStream firmware and the UniLogic 

application via both UniApps and Ladder functions. The files may be 

located on either an SD card or an USB DOK stick.

Camera: Capture New ladder elements allow you to capture images and video from a 

USB Camera

Screen Saver Mode Screen Saver is a new option in Hardware Configuration>Controller 

Model>Properties>Screen Saver. When you check this, it enables the 

UniApps Screen Saver mode. Via UniApps, you can then activate 

Screen Saver to enable its options: you can power off the screen, and 

enable recovery via VNC.

You can also set Wait time from last touch, when this timeout elapses, 

the screen will turn black. You can also control brightness to save 

power.

MODBUS

Improvements, New 

Options

MODBUS has improved functionality, and supports new options:

• Modbus>Add New Operation now offers an Add New Batch 

Operation option.
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• Floating point MODBUS registers can be swapped automatically 
during read or write operations.

• MODBUS RS485: when there are multiple slaves, and some of 

these are disconnected, the system performance is improved.

HART: New Features This version provides new HART Ladder elements: HART Command 

Builder, and HART Response Parser.

Serial communication 

over USB: USB to 

RS485

UniStream Built-in & UniStream PLCs now support specific HID USB to 

RS485 adapters, from Silicon Labs/DTECH and FTDI.

Additional Features

Protect Application
Intellectual 

Property

You can now include a specific UniStream's serial number in a Exported
Project File. Attempting to install the file to a different controller 

using Update Application ladder functions will give error -9

System Error struct Use the System Error struct to troubleshoot errors.

System Events Log A log on the SD card located at SystemLogs/UniStream.log records 

major events such as download, upgrade, powerup, and more

Data Sampler • The Data Sampler properties window now offers a new option, 

Sign Files. Check this to create a signature for your BIN/.csv files.

• The Data Sample struct now enables you to set a Delimiter 

character to be used in the CSV file

Alarms In Alarms general properties, you now have the option to create .xml,

.csv, and .zip Alarm logs and sign them.

Application 

Signature

Via UniApps>System> UniLogic App, you can now view the App 

Signature in addition to the application name and version.

Email • Composer: you can now include a string variable in email 

messages.

• Send email Timeout: You can new set a Timeout

• A new status message has been added to the email struct: - 

10 unable to get local issuer certificate' when sending an email

SD/DOK Status 

Notifications

When the SD/DOK is locked, or almost full, the system error struct is 

updated.

Ethernet IP EDS EDS tags now include descriptions

VFD VFD Run Frequency - the Frequency parameter is now an optional 

setting. When frequency is not set, the current set frequency will be 

used.

High Priority Ladder 

Task

High Priority Ladder Task now offers new Ladder elements: Reset 

counter + Reverse Counter

SMS You can now add more than one contact in the SMS address list.
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User Files CSV and XML filenames inside a .zip attachment will now include the

timestamp

LF: Copy/Move 

folder to DOK

A new FILE>Copy/Move folder to DOK ladder function allows you to 

move folders to a USB DOK.

UCR Router
New members have been added to the UCR Router Struct 

for Daily/weekly/monthly data usage counters

UCR Incoming caller ID identification has been added.
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Minor Features 

• Structs: You can now right-click a Struct to duplicate it and edit its members.

• OPC-UA: You can now:

• Import an OPC-UA file from the SD Card, not only from a DOK flash drive.

• Set the OPC-UA namespace from UniLogic in the OPC-UA Settings

• URB: Allow to duplicate URB coupler structure and configurations.

• HMI and Web page element Actions now enable you to Reset a Numeric Value.

• UniApps: you can now import and export application configuration parameters from and to a 

DOK flash drive, such as FTP, email, modem, SMS configurations and more.

• UniApps clock, auto-sync: if you select auto-sync is ON, an attempt to sync the clock will now 

be made every 12 hours, in addition to every action that requires HMI reset, such as reboot, 

and download.

Bugs 

• Keyboard: would show Cyrillic-Serbian instead of Serbian-Latin

• Data Sampler: CSV+Zip would not be saved to history on power-up.

• Online Mode:

o did not disconnect when updating the application from a ladder

o when using constants, incorrect tooltips were displayed

• SQL DT->SQL: would fail when DT "From Row" was above INT16

• UniLogic C Function: When referred to a struct, wrong comments were added

• UniCloud: Creating an Asset on the PLC causes HMI Overload on some scenarios

• USBF action: Change Password was not working

• Servo:

o Servo Homing Method – Positive and Negative velocity were greyed out

o Importing a motion application could cause the UniLogic to crash

• HMI: HMI Overload occurred after reboot when Start/End Sampling bit was on at start-up

• Router Success bit and Signal Quality did not update when there was no connection

• UniApps->Network->Serial: only the first serial port was available

• VNC: Connection count and Connected Bit did not update after disconnecting

• BACNet:

o I/O properties were not saved

o Server IP did not refresh automatically

• OPC-UA: Will not require reset on every download

• Remote upgrade was not cancelled after the connection was made to PLC

• UniLogic, PC-PLC Communication: when download port 22 was incorrectly configured, UniLogic 

approved PC-PLC Communication with a green checkmark and provided inaccurate 

communication error messages

• Email:

o Mail Configurator Widget did not add recipients to email



o Sending an email with multiple TO/CC/BCC would fail if the 1st address was an empty 

string

o Send email from UniApps - always sent from the first account

• SFTP Client: would fail due to Failure establishing SSH session

• MQTT: Wildcards having 'A/B/+/+/C' did not work correctly

• CANopen:

o Did not send 2 SDOs in a row

o A sequence of "Init Node EDS" ladder functions being executed one after another could
cause a CPU error

o CANopen Auto-Start could cause a CPU errors

• UniCAN:

o Incoming messages were lost

o After CANBus Disconnection, there's no need to reset PLC to re-establish the 

communication

• Modbus Master on USB port would sometimes stop working

• Alarms: suppressing Alarm with ID higher than 255 did not work, and would suppress the 

wrong Alarm

• CSV: Convert CSV to UDTF failed after download

• I/O:

o UIA-0402 outputs did not work properly

o UIS-08TC did not show temperature when "Noise Rejection" set to 10 Hz. Other values 

worked properly.

UniLogic® Service Pack V 1.32.xx UniStream® OS 1.32.xx, January 2021

Ths service pack brings you the features and bug fixes listed below.

VNC Server 

Management

• 'Portrait Mode', UniStream PLC and UniStream Built-in: Portrait Rotation is 
set to 90% by default.

• VNC Server Management has been moved from Passwords to its own 

location on the Solution Explorer tree, directly under PLC Communications.

• The VNC Server Password is now in this section, and not in Passwords.

SD

Management

• Note that the option 'Is Rule Enabled' is now checked by default for all 

file types for all projects. In addition, updating an older project will check 

the option for all file types.

• SD management has been moved up the Solution Explorer tree to a new 

location, directly under Hardware Configuration.

TCP/UDP

Socket

CPU communications: a project that uses TCP or UDP Tx functions must also

contain an Rx function. UniLogic now issues a compilation error if Rx functions 

are not included in the project.

SMS You can now include up to 10 numbers in the SMS number list.

VNC The System>General tag Number of VNC Connections will be initialized when 

the system recognizes that the Ethernet cable is disconnected, turning the 

System>General tag bit Ethernet Port Link OFF for the port.

New Help Topic 

ERRNO

UniLogic provides ERRNO - Error Codes that report and retrieve errors for 

Ladder functions.
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Under System > Ladder ERRNO, you can find tags for the Function Index and 

Error Number.

Bugs fixed in this version 

UniLogic

• Animated .gifs: previously, in cases where a display contained more than one language, 

UniLogic did not check the number of animated .gifs per screen; the limit per screen is 4. 

UniLogic now issues a compilation error for all displays containing more than 4 animated gifs.

• CANopen EDS files containing space characters would fail to load; UniLogic now compensates 

for spaces.

• Router struct name can now be edited after re-opening a project.

• UniStream PLC: setting/changing passwords via USB did not always work properly.

• Data Sampler: CSV+Zip was not saved to history on power-up.

• Remote upgrade: the user could not cancel remote upgrade after the PLC was connected.

• Unnecessary compilation error was given when the last I/O module was removed from the 

configuration.

• Find in Array Back ladder function could not search for a bit data type.

• Mail Configurator Widget failed to add recipients to emails.

UniStream

• Alarms: selecting an Alarm ID higher than 255 would result in the wrong Alarms being 

suppressed.

• Disconnecting/Reconnecting I/O might cause a CPU Error.

• Ethernet/IP counters: values were not stored.

• UniApps, RTC auto-sync: would stop working after 24 hour. Now, when auto-sync is on, the 

controller will attempt to synchronize the RTC every 12 hours, and at every PLC reset.

• CANopen:checking the Autostart option would cause CPU errors.
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Features

HMI:

New Action

Use Reset Numeric to enables your users to reset a value via the HMI.

Find
• Finding 'Todo': searching for ToDo now includes Region Comments.

• You can now also search for text in Comments

• The Find Results pane now maintains a history of up to 15 searches.
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LF: Struct to/ 

from Buffer
These functions now work within UDFBs, as 'Function In' elements.

Message 

Composer

You can now right-click Devices and Messages and export/import them between 

applications.

BACnet IP Via UniApps, the user can:

• Enable/Disable BACnet

• Set Object ID from UniApps

Ethernet/IP
When exporting an EDS file that contains ASCII strings, a message now appears 

to recommend that the user convert the string using the Tag to Buffer Ladder 

function, thus enabling the strings to be exported.

email
• The list of elements that you can include in an email now includes String 

Variable.

• email Recipients: Strings can now display recipient addresses.

• If the 'From' field has been left blank, a compilation message now 

appears.

Alarms Alarm widget: ‘Severity’ columns can now be translated

OPC_UA You can now Export/Import Address Space.

MODBUS Now, as you add/delete each Modbus operation, UniLogic increments/decrements 

their number.

UniApps, VNC 

Server
UniApps>Networks> VNC Server now displays a list of up to 8

connections. When the list exceeds 8, the controller automatically disconnects.

FTP/SFTP

Passwords

Cases where the programmer uses illegal characters in creating a password now 

display a warning, and also gives a compilation error.

Bugs fixed in this version 

UniLogic

• Motion:
- In certain situations, compilation would fail due to the Drive struct
- Adding the Servo and VFD diagnostic applications caused a compilation error

• Tag Import: duplicating a tag name that was used as an alias would crash UniLogic

• DOK: in certain cases, updating the DOK would crash UniLogic

• XY Trend: background was not transparent when selected

• UniStream keypads: if two keypads were opened on screen, the first remained onscreen, but 

was not responsive

• 'Load config from INI': DNS settings were not always supported

• HMI, .gifs per screen: a message now appears to warn the user if the number of gifs exceeds 

the recommended level.

• Functions called via Switch Case: would be mistakenly given a compilation warning.

• UniStream model, webserver: if the PLC model was changed from one that supported 

webserver to a model that did not, the user would be warned that webpages woud be deleted-- 

even if the project did not contain a web server configurayion.

UniStream

• Downloading a blank application (download + Reset) might cause a CPU Error

• BACnet Server IP - Binary Value/Input object did not allow writes
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• VNC Server:
- after downloading certain projects, VNC server did not allow connection

•  - when VNC server resolution was changed in UniApps, the resolution was not retained after 

reboot

• SMS: If a phone number was not set, Sending SMS via Router provided an incorrect error ( 

SMS_ROUTER_GENERAL_ERROR = -7) when the correct error was SMS_TEL_NUM_ERROR = -3 

(

• VFDs: :
-writing configuration files to 2 VFDs resulted in a CPU error

•  -VFD is Connected bit sometimes rose to True too early, before the authentication process had 

been completed.

• IO module (UID-W1616R) power LED blinked in certain cases where Message Composer was 

included in the project

• UniStream Built-in - in cases of Boot error, a 'check physical connection' was incorrectly 

displayed; this has now been replaced with a 'Contact Support' message.

• Mail Configurator Widget: selecting To/Cc/Bcc resulted in 'HMI Application Overload'

• FTP client: failed to connect when the $ symbol was used in the password

• Rest API: Send Value requests sometimes resulted in outdated values being sent

UniLogic® V 1.32.00 UniStream® OS 1.32.00

Features

VFD: Ready-made VFD 

Motion code

UniLogic's Ready-made VFD Motion code enables you to get moving 

immediately—and does most of the work for you.. The application 

includes both Ladder & HMI screens to enable you to run Diagnostics. 

You can also edit it to suit your application.

You simply import the code, call it into your application, download it— 

and start moving.

HE: VFD Drive Selector 

Widget

Place this widget on an HMI screen to enable the end user to select a 

VFD drive via the UniStream panel.

Data Tables LF: DTI to File

You can now select to retain formatted files: .csv .udtf, and csv.zip 

files.

UniCloud: GPS Router 

Support (s

***Note that this feature is not yet supported in UniCloud, but will be 

included in a future version.When you created a UniCloud Asset type, 

you can enable Router Settings> Use GPS Location.

If your UCR Router supports GPS, this will cause the Asset location to 

be harvested along with all of the other Asset data.

Bugs fixed in this version

• DOK: Safely removing a DOK (USB memory stick) would cause an incorrect message to be 

displayed.

• Ethernet/IP EDS:
o • EDS Import functioned improperly in certain cases of tag conversion and Assembly arrays.
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o • I/O struct names would appear editable upon reopening project.
o • Short string import might cause an error

• Log upload: in certain cases, passwords were not correctly validated.

• Alarm History Widget: was empty after re-boot.

UniLogic® V 1.31.177 UniStream® OS 1.31.69

Features

Store DTI to file As of this version, the defined decimal format is retained for .csv files.

Export Data Table to File Array member names are now visible

Languages This version contains Polish language additions

MQTT As of this version, MQTT subscriptions ending with '+' are supported.

Bugs fixed in this version

• VNC: the value in Number of Connections was reset after a disconnection.

• UIS 04PTN: incorrect values were shown

• VFD Configurations: attempting to write configuration values to multiple VFDs might cause a 

CPU error

• Data Tables, UniLogic: when defining Data Tables in Web server, the text 'Undefined' was 

displayed instead of the actual value.

• EtherCAT: Adding a new PDO would sometimes cause UniLogic to crash

UniLogic® V 1.31.70 UniStream® OS 1.31.60, June 2021

UniCloud, 

New Feature 

Support

This version supports new UniCloud widgets Switch and Update Asset.

Note that in order to use them you must update your UniStream OS, included 

with this version of UniLogic; in addition, note that the tags in the Asset type 

must be set to Read/Write.

For full details regarding UniCloud updates, log into UniCloud.io and open the 

Help menu. Version changes are listed in the Welcome topic

You can now sync your PLC's RTC with the current time for your time zone with 

the server at https://worldtimeapi.org/timezones. A new option, Auto-Sync, 

enables a PLC with an internet connection to remain synchronized with the 

server, and automatically change to/from Standard to Daylight Savings time.

The new Ladder element Read Line from File enables you to this to read a line 

from a file on the SD card into a buffer.

UniApps: 

Auto-Sync 

RTC

New Ladder 

Element

Controller 

Popup 

Messages

System Popup screens for HMI Overload now provide instructions to the user

https://worldtimeapi.org/timezones


50

XY Trends In XY Trends Curves, you can now set the Y-axis to REAL, using up to 6 decimal 

places.

CSV Decimals In CSV files, REAL numbers can now show values including up to 6 decimal 

places

Bugs fixed in this version

• Ethernet: changing serial remote slaves ID via UniApps caused the remote slaves list to be empty

• MQTT:
- After broker reconnection, subscriptions did not work properly
- Certificate import sometimes caused brokers to be automatically created
- HMI Overload screen would be displayed, when MQTT auto-connected to broker and Connection 

interval is 0

• REST API Queries: INT16 and INT8 could not be used in query parameters

• REST API Requests: using tag parameters after hard-coded parameters did not work properly

• DT columns, HMI widget: column headers did not display properly after scrolling left and right

• Ladder comments: could not be opened if comment height was insufficient

• Download: in certain circumstances, projects would crash when compiling a project for download

• Keyboards connected to UniStream via USB port did not recognize certain characters

• UniApps:
- Serial configuration could not be edited.
- VNC: after changing the VNC server resolution from UniApps and rebooting, the resolution was 

not retained

• Alarms:
- Banner, 15" UniStream: Text frame was incorrectly sized, when using "by Highest Severity" 

banner color mode.

- Alarms occasionally crashed in certain situations.

• email: in certain cases, the 'fail' indication was set to ON, even though the email was successfully 

sent.

• UniLogic Hardware Configuration:
- a popup for I/O UID-0808T upgrade would be displayed, even when the UID-0808T was not 
included in Hardware Configuration
- Compilation error: in certain circumstances, a compilation error was shown if UAG-CX-XKPLXXXX 
was included in Hardware Configuration

• Router: When the router is disconnected from the controller, the Router Success bit and Signal 

Quality value remained unchanged.

UniLogic® V 1.31.146 UniStream® OS 1.31.122, March 2021

Features

REST API REST API now supports:

• HTTPS Servers.

• The Buffer data type, in the Response parameters.

MQTT Broker Connections now support MQTT/SSL -- Google Cloud IoT



51

UniApps • MODBUS: in UniApps, under Network> MODbus, you can now access Ethernet 

Master and Slave with an ID#=0.

• HMI Reset: in cases where the HMI application requires reset, the re-designed
message screen now instructs you to extract the system log to USB or PC, so 

that you can send it to Unitronics Support.

• Show Suppressed State in Alarm Summary and History: if, in the Alarms global 

Properties, you check the option Show Suppressed Alarms, 'Suppress' will be 

displayed in the Value column for suppressed Alarms.

• German: Alarms Status, History, and Summary may now be viewed in German

Alarms

Project 

Signatures

The signature log has been expanded to include: import of Ladder, HMI, Web, 

Message Composer, Formula, Import Data Sampler, Remote Modbus Slave, and 

Alarms, as well as converting HMI displays to Web pages

Bugs fixed in this version

• PLC communication password: In certain cases, UniLogic requested a password when no 

password was required.

• REST API: in some cases, slashes at the end of End Point Resource were ignored.

• Alarms:
-Version 1.31.125: names were not preserved at import.
-If a user cancelled Alarms Export, UniLogic showed an 'Alarm Export Failed' message.
- Alarm headers occasionally aligned incorrectly
-In certain circumstances, icons did not display at 1024x600 resolution

• Ethernet/IP:
-In certain cases, importing an Ethernet/IP EDS file containing bit arrays caused errors.
-In certain cases, an Ethernet/IP EDS file exported with minor Errors (set Run Idle bit).
-Commas used in parameters names were incorrectly read as delimiters.

• HMI Editor, Panel Orientation:
-Changing models sometimes affected panel orientation (landscape/portrait)-When the project 

was based on UniStream PLC (USC) models, changing the panel orientation sent the UniLogic 

window backwards.

-In portrait mode, the Title of the Alarm History widget overlapped the CLR button.
• Structs:

-Minor errors sometimes occurred in autocomplete.
-Adding a Description with two lines caused a compilation error.

• In Hardware Configuration, the URB module URA-0008Y was shown as AO08W.
• WebServer: occasionally projects including webserver showed an error after download.
• Including the character " \" in the Caption in the Properties window of an HMI or Web Data 

Table caused an "Error while reading data", and in certain may have caused a CPU error.
• Remote upgrade: changing to another IP without refreshing before beginning the upgrade 

would cause the window to close.
• In certain cases the controller required HMI reset; in most cases, the controller will now recover 

without user intervention.
• URB modules were sometimes missing from Function In after re-opening project
• OPC-UA: operands sometimes did not update correctly.
• BACnet: operands sometimes did not update correctly.
• Alarm headers occasionally aligned incorrectly.
• UniCloud: Sync Asset Type with UniLogic automatically created structs
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UniLogic® V 1.31.116 UniStream® OS 1.31.94

This is a Service Pack for version UniLogic 1.31 Rev106 and UniStream OS1.31.81 

released in January 2021.

Features

• UniStream 'Cloud' controllers: All 'C' series model numbers are now available in Hardware

Configuration. UniStream 'Cloud' controllers are an industry first: a PLC with built-in, no-cost cloud services. 

Each UniStream Cloud PLC is supplied with a pre-paid 5-year Start-up Subscription plan-there is no monthly 

subscription fee.

• You can now export the error and status messages generated in UniLogic, via new Export to Excel tab in the 

Error window.

• New Baud Rate added to CANbus: 100Kbit/s

Bugs fixed in this version

• EthernetIP: could sometimes not upload an EDS file.

• Modbus TCP: did not support Unit ID 0.

• OPC UA: would sometimes duplicate Tag names.

• Application import did not work in certain circumstances.

• In certain cases, older applications did not open.

• Emails: in certain circumstances, the controller did not send emails.
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UNILOGIC® V 1.31.106 UNISTREAM® OS 1.31.81

Unitronics first 2021 Release supports EtherCAT, the industrial fieldbus protocol that drives powerfully 

precise processes in factories across the globe, is now easily implemented by UniStream® PLC* series.

Our new EtherCAT Master module enables you to integrate:

• Unitronics EtherCAT Servo_Drives
When you use a Unitronics drive, EtherCAT data exchange is transparent. You can implement 

motion using UniLogic's Motion function blocks. A single UniStream can support up to 8 drives. 

Plus, you can easily adapt any Motion application based on CANopen to EtherCAT simply by

making a few changes in Hardware Configuration

• Unitronics URB EtherCAT adapter
Via an EtherCAT URB adapter, you can communicate with Unitronics URB Ethernet-based I/O 
modules

• Third-party EtherCAT slave devices
You can import a device's definition file, and exchange data via Ladder using SDO requests.

A single UniStream can support one EtherCAT master module, which can support a total of 32 

EtherCAT nodes. This includes EtherCAT Servo drives, Remote URB adapters, and third-party EtherCAT 

devices.

*EtherCAT is currently supported by USC-B5 and USC-B10 only.

Features

EtherCAT Master 

Module

*Required for ALL 
EtherCAT communication

Hardware Configuration now offers a new EtherCAT Master 

Communication module, the UAC-01EC2.

This new COM master module enables you to base Motion applications on 

EtherCAT, to use Unitronics' URB I/O via EtherCAT, and to include third- 

party EtherCAT device in your applications.

You can now use Unitronics new EtherCAT Master module in conjunction 

with Unitronics new UMD-E3 EtherCAT servo drives to easily build Servo 

Motion applications.

All of UniLogics' PLCopen-compliant MC Function Blocks are supported 

over EtherCAT as well as Ready-Made Motion code.

Hardware Configuration now offers the URB-EC1 EtherCAT adapter, which 

can support up to 16 URB I/O modules per adapter.

Servo Motion 

via EtherCAT

URB EtherCAT 

Adapters

Third-party 

EtherCAT

You can import the ESI file of a third-party EtherCAT device and include it 

in your application, communicating data via EtherCAT SDO Read and 

Write Ladder functions.

New Ladder Elements enable you to reset, and to set the timeout of, a 

URB TCP module.
URB TCP
Adapter LFs

UniCloud This release is the first to support UniCloud, a complete, no-code IIoT 

Cloud Platform specifically designed for the OEM and Machine Builder.

You can export a complete project to a local or external drive, and then 

import/upgrade the exported Project File into any number of PLCs as a 

new project, or use it to update an existing base project. You can import 

a project file via UniApps, or via a new Ladder function, Update 

Application.

Export Project File

Additional Features

file://///localhost/F:/!!!!UniLogic_Current_2020/EtherCAT__Third-Party_Devices.htm
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Alarms • Banner Color Mode: a new property in the Alarm Property Window enables 

you to assign an Alarm banner color according to the highest (severity) 

active alarm level, instead of a fixed color.

• Alarms Struct: new tags enable you to keep track of the count of the 

number of alarms in the Alarm History and Alarm Summary.

• Alarm History Widget, Clear Button: in the widget properties, the new 

Show Clear Button enables you to display a CLR button that can be pressed 

by the user to clear the Alarm history.

OPC UA You can now set tags to read /Write or to Read only in the Address Space 

window; under Access Levels.

These can now be saved within your project.Ethernet 

Favorites

Ladder 

Rungs & 

Comments

You can now drag the borders and resize them.

Data Tables • A new parameter, Digitally Sign file, in the Ladder function Store DTI to file 

enables you to assign a Data Tag to determine whether or not to digitally 

sign the file: 0 = Don't sign 1 = Sign

• Improved Array appearance

Buffers • The functions Tag to Buffer and Buffer to now support a BIT array tag type.

• Buffers now support Load from Array and Store in Array.

XY Trends View Data Values: Your users can now touch the curve and view the sampling 

value & time while an XY Trend view is in Stop mode. Touch View Data, then 

touch the active curve to display two yellow lines that intersect at the touch 

point. Use the arrows to move the point along the curve.

If you select one of the following elements in the Ladder, you can press F12 to 

find all instances.
Ladder: Find 

element via 

F12
• Call function ladder element

• Switch case ladder element

• Jump to region

• Formula

• Send SMS

• Receive SMS

• Send mail

• SQL elements

Toolbox You can now search for toolbox elements while in online mode

Ladder Right-click any Ladder element and select Pin to Bottom Bar to add it to the 

Ladder element bar at the bottom of the Ladder Editor

During runtime, the Trend represented on the panel now offers a button that 

the user can press to toggle the width of the curve line.
Trends, Curve 

Width
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Bugs fixed in this version

• EthernetIP Node Struct: when adding a Scanner node using an EDS file, the new 'Config' tag did 

not appear hyperlinked

• Importing tags from Excel did not always function correctly.

• Application Download: in certain cases, users could not download applications, in version 1.30

• WebServer: Press /Release button function did not work as expected on mobile device browser

• BACNet server: appeared to be in Init status, although it was running

• Modem Signal Quality: if a Modem and a Router were in the same application, the signal quality 

was reported incorrectly

• Trends: in certain circumstances, using the Time Span option caused the system added an 02 

before the actual time in X axis

• UAC Account would sometimes lock in certain circumstances after downloading an application

• XY Trend: a user needed to Stop the Trend in order to switch to the next curve

• Ping Ladder element Time out did not take effect, affect when pinging from the CPU

• UAC Idle timeout did not work from VNC

• A Compilation Error would appear at download if the file name in Write VFD Parameters was 

changed

• Alarm History Widget: would stop presenting new data after approximately 10 days

• Network Error sensitivity improved
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UNILOGIC® V 1.30.62 UNISTREAM® OS 1.30.51

This is a Service Pack for version UniLogic 1.30 Rev62 and UniStream OS1.30.51 released 

in December 2020

Bug Fixes

These bugs are fixed in this service pack:

• In certain cases, UniStream PLCs (USC series) could not boot up due to SD card installation 

errors.

• UniLogic HMI Editor: the HMI Element Properties window loaded slowly when moving between 

elements.

UNILOGIC® V 1.30.58 UNISTREAM® OS 1.30.43, September 2020

This is a Service Pack for version UniLogic 1.30 Rev52 and UniStream OS1.30.31 released 

in September 2020

Bug Fixes

These bugs are fixed in this service pack:

• PTO sometimes functioned incorrectly

• VNC Server:

- Using a direct contact element for the "General.VNC Touched Bit" would cause a compilation 

error

- Checking the "App resolution" checkbox would cause the "With cursor" and "Set 'Touch bit'" 

checkboxes to be disabled

• Library, C functions: importing a C function from the Library would cause UniLogic to delete the 

code from other C functions in the project

Improvements

• Trends:

- Trend widget loads faster

- Now supports axis values

- • Global tag import: now includes a 'Cancel' import option

• REST API:

- if the Base URL is invalid, UniLogic now gives a compilation error

- REST API compilation errors now allow you to click in the error list directly to the error 

location



UNILOGIC® V 1.30 REV52 UNISTREAM® OS 1.30.31 September 2020

Unitronics Fall 2020 release launches a new 

member of the UniStream series: a 

UniStream Built-in controller with a big 

10.1'' panel offering 1024 x 600 (WSVGA) 

resolution.

As a PLC + HMI + I/O, UniStream 10.1 is 

available in a broad range of expandable, 

built-in I/O configurations, and is available

in Standard (B5) and Pro (B10) models. Both models support advanced communications, 

including MQTT, VNC, FTP, SNMP, email and SMS messaging. The Pro version also offers 

built-in Webserver, video support and SQL.

UniStream Built-in benefits include auto-tuned PID, data logging, data tables and recipes, 

data sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords, 

portrait mode, and plug & play communications for CANopen, CAN Layer2, MODBUS, 

EtherNet/IP, Servo made Simple, and more.

Other release features include support for:

• New USL external VNC display panels for UniStream: ‘big-screen’ USL 15.6'' & USL 10.1''

• REST API

• PTO, via I/O Module UID-0808THS

New Hardware

NEW

UniStream Built-in 10.1

With a big, 10.1'' Panel offering 1024 x 600 (WSVGA) resolution, 

UniStream 10.1 is available in a broad range of expandable, built-in 

I/O configurations - available in Standard (B5) & Pro (B10) models.

Both versions support advanced communications including MQTT, VNC, FTP, SNMP, email and SMS 

messaging. The Pro version also offers built-in Webserver, video support and SQL.

UniStream’s built-in benefits include auto-tuned PID, data logging, data tables and recipes, data 

sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords, portrait mode, 

and plug & play communications for CANopen, CAN Layer2, MODBUS, EtherNet/IP, Servo made 

Simple, and more.
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Models Features

US10-B5-B1 

US10-B10-B1
No built-in I/Os

US10-B5-TR22 

US10-B10-TR22
10 Digital, 2 Analog Inputs, 2 Transistor outputs, npn, including 2 PWM outputs.

8 Relay outputs

US10-B5-T24 

US10-B10-T24
10 Digital,

2 Analog Inputs, 12 Transistor outputs, pnp, including 2 PWM

US10-B5-RA28 

US10-B10-RA28

14 Digital, including 2 HSC,2 Analog Inputs, 2 Temperature inputs, 

8 Relay outputs, 2 Analog outputs

US10-B5-TA30 

US10-B10-TA30

14 Digital inputs, including 2 HSC, 2 Analog inputs,2 Temperature inputs, 

10 Transistor outputs, pnp, including 2 PWM, 2 Analog outputs

US10-B5-R38 

US10-B10-R38
24 Digital inputs, including 4 HSC,

12 relay outputs

US10-B5-T42 

US10-B10-T42

24 Digital inputs, including 4 HSC, 2 Analog inputs, 

16 Transistor outputs, pnp, including 2 PWM

NEW USL

Displays

Big-screen UniStream USL Displays 10.4" and 15.6" are, included in this 

release.

UniStream Displays are a series of color touch-screens that support VNC.
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REST API
A UniStream controller can operate as a REST API client and can request 

specific data from a server. In order to communicate with an API REST server, 

you build a request, comprising Query and Response Parameters.

PTO
You can now implement Pulse Train Output (PTO) via the high-speed outputs of 

I/O Module UID-0808THS.

Using PTO you can, for example, build Motion/Speed profiles that are 

appropriate for stepper motors.

New Time- 

savers: 

Development 

Mode & Quick 

Sync

Development Mode and Quick Sync are time-saving features that can help you 

to develop UniLogic projects more efficiently. You can use them independently, 

or both together.

Development Mode: when enabled, this mode saves time by 

temporarily suspending, for 1 hour, the password verification process 

performed between UniLogic and UniStream at download.

Quick Sync: downloads small changes in Ladder, Message Composer, 

Switch Case, and Formula, while other changes are ignored. This can 

save significant download time during project development.

The new UAC features listed below are useful for all, but are especially needed 

for UAC projects supporting the standard CFR-21 part 11:

UAC User Groups, new Password features:

UAC: New

Features
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Expired On: Password ageing, the number of days a password will be in 

effect for a member of a group before it expires.

Lockout Timeout: Determines the number of minutes the user will be 

locked out before being allowed to attempt to log in.

Login Attempts: The number of Login attempts a member of a group 

may attempt to login before being locked out.

Alarm Status Viewer widget: If you enable UAC, you can select if 

buttons--ACK, CLR, Disable and Shelve Alarm--will be visible to a specific 

User Group.

Additional features

HMI Trends:

o  When a Trend graph is displayed, you can now press a new button in the top left corner 

to hide the buttons and increase the viewing space, and press again to display them.

o Trend properties now include an option to change the background color of the Curve text 

(the default is black)

Via UniApps, you can now enable UniStream to register when a connected VNC client screen is 

touched. In UniApps, access the Network tab-> VNC Server, check the Set 'touch bit' and press 

apply. The VNC server will restart with the VNC "touch" identification option enabled.

USB Action Files: you can now include a PLC Password, selecting either to retain the default password, or 
overwrite the current password with a value that you provide.

Modems: when you add a modem, you can now add a Signal Quality Refresh Rate. 

Message Composer: now supports REAL tags.

Bugs fixed in this version

These have been fixed in the current version: 

MQTT  Minor bug fixes

Modem / SMS / Email: emails were received from certain servers without a 'From' header.

USL: sometimes was is disabled in UniApps.

UAC: Users could log in, although another user was already logged in; a notification will now 

pop-up requesting logout.

Ethernet/IP In certain circumstances, EDS import would fail.

HMI keyboard: in Portrait view, the alphanumeric keyboard was missing the Z character. 

UniApps: Project Export to USB stick did not request a password.
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UNILOGIC® V 1.29 REV103 UNISTREAM® OS 1.29.128 May 2020

Unitronics Spring 2020 release introduces brand new hardware and powerful new software 

features to broaden your project potential!

New Hardware

• New Ethernet-based URB components:

- I/O modules: Loadcell/Strain-gauge, PWM, and Pulse I/O modules
- I/O adapter:URB-TCP2, a compact, competitively-priced adapter that supports up to 6 

URB I/O modules.

• Introducing Unitronics 4G Routers! Our new 4G/LTE & WiFi cellular Routers support 

embedded SMS functionality, RS232, RS485, GNSS (GPS), microSD, USB interface, and 

on-board Digital & Analog I/Os.

New Software

• BACnet IP Server: Yes, UniStream controllers as BACnet IP Servers! The broad range of 

Services, Objects, and Tasks enables you to blaze new ground in Building Automation 

and Environmental Control. Compatible with all UniStream controllers. We invite you to 

activate the trial license to check it out!

• High-priority Ladder Task + Immediate Ladder Functions: *Supported by the following 

models: US5/7-B5/10-T42 and USC-B5/10-T42. .

• Motion Control: - Update Firmware Wizard: | New Motion Control Functions: Apply Torque

/ Apply Force | New Actuators: Rack & Pinion, Roll-feeder / Conveyor |- Upload Axis 

Parameters to PC

• EtherNet/IP: New EDS Features: Scanner: Import a manufacturer's EDS configuration| 

Adapter: create and export an EDS file for adapter nodes you define in UniLogic.

• Authentication New!: Embedded user authentication now requires a PLC password before 

executing commands and tasks; simply install this UniLogic version, upgrade UniStream 

firmware--and gain increased security.

Regarding Authentication: Unitronics tracks the dynamic challenges that cybersecurity present 

to industrial automation. This version requires users to enter a PLC password before executing 

commands and tasks. UniLogic includes a default password. Please change the default 

password to minimize exposure to un-authorized cyber users.

We highly recommend you take this 

opportunity to benefit from the 

increased security offered in this 

version release.

To do so, you must update your 

UniLogic software, upgrade UniStream 

firmware, and download an application 

created/updated in this current version.
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Read on to learn of other exciting features in this release, including new servo Motion 

Control functions, new Actuators, and more!

Spring 2020 Feature List

NEW in

Remote URB I/O

Hardware Configuration now offers new additions to our line of URB Ethernet- 

based Remote I/O:

Compact I/O Adapter URB-TCP2, which can support up to 6 URB I/O 

modules

New I/O modules, including Loadcell/Strain-gauge and PWM modules

Model

URS-02LC-8 

URD-04PW 

URD-02PW 

URD-02PU 

URA-0800T 

URA-0800U 

URA-0008Y 

URA-0008Z

Feature

Load Cell

PWM, 4 Channels

PWM, 2 Channels 

Pulse2 Channels

8 Analog Inputs, Current 

8 Analog Inputs, Voltage 

8 Analog Outputs, Current 

8 Analog Outputs, Voltage
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Routers
Unitronics new 4G cellular routers enable you to send and receive SMS messages via 

Ethernet. Hardware Configuration now offers these models:

• UCR-ST-B5
4G /LTE & WiFi cellular router with 2 Ethernet ports and I/O

• UCR-ST-B8
Dual-SIM 4G/LTE & WiFi cellular router with 4 Ethernet ports, Digital & Analogue I/Os, RS232, 

RS485, GNSS (GPS), microSD, and USB interface
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BACnet Server
A

UniStream
controller 

can now

act as a 

BACnet 

Server, 

supporting 

a range of

Services, Objects, and 

Tasks.

Note that BACnet Server requires a license 

purchase, available from your Unitronics' 

sales representative.

Unitronics offers you a One-hour Trial Offer, 

in order to enable you to explore this new 

exciting feature. Note that each time you 

power up your controller, you can restart 

the One-hour Trial Offer.

To learn how to activate the Trial Offer, refer 

to the BACnet Server topic in the UniLogic 

Help.

Ladder: High- 

priority Ladder 

tasks 

(Interrupts)

A High-priority Ladder task runs independently of your Ladder
program according to a specific time interval. Use them with Ladder functions 

Immediate Read Input/Input, Immediate Set/Reset Output.

These features are only visible in UniLogic when you select supporting models 

in Hardware Configuration, such as the US5/7-B5x-T42 and USC-B5/10-T42; 

when unsupported models are selected, these features are hidden.
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Authentication: 

UniLogic to 

UniStream

Starting with this UniLogic version and the accompanying UniStream 

firmware, Unitronics embedded user authentication measures into both 

UniLogic software and UniStream firmware. This enables you to prevent 

unauthorized access to your UniStream controller.

For this reason, UniLogic requires users to enter a PLC password before 

executing commands and tasks that require UniLogic to UniStream 

communication.

The first time a user establishes 

UniLogic to UniStream communications 

to a particular PLC, for example at 

application download, or to run online 

Test mode, UniLogic prompts the user 

to change the default UniStream access 

password.

For details, including how to restore the 

default password, refer to the Help 

topic Authentication: UniLogic to 

UniStream

Motion 

Control

This version offers several new Motion Control features, plus a new Servo Firmware 

Update wizard.

Update Firmware Wizard

You can easily update your 

Unitronics' UMD Servo firmware 

via the Wizard, now available on 

the Servo Drives ribbon tab.

New Motion Control Functions

The Ladder Toolbox offers two new MC functions:

MC Apply Torque
Enables you to set Torque and apply it according to the physical values you define in the Axis 

Configuration, regardless of the motor specification.

• MC Apply Force
Enables you to set Force and apply it according to the physical values you define in the Axis 

Configuration, regardless of the motor specification (linear actuators only).

In addition, MC Move Relative and MC Move Additive now support Continuous Update; set a bit to 

evaluate input parameters at each cycle.
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New Actuators

Two new actuators are available: Rack & Pinion, and Roll-feeder / Conveyor, allowing you to 

convert rotary movement to linear values.

Upload Axis Parameters to PC

When you configure an axis, the values you enter in the Axis Struct are written to the axis at 

power-up. When you enter values from the HMI, the axis functions according to these values, but 

the values you have entered will be overwritten at power-up.

To overwrite the values in the axis struct, use Upload Parameters in PC.
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Additional Motion features

Axis Interface: Automatic conversion and rounding in Actuator properties. When you change the 

Unit setting, UniLogic now converts the value; for example, if Unit was set to μm and the value was 

1000, setting the units to mm converts the value to 10.

Custom Units: You can now select Custom Units when working with linear actuators.

EtherNetIP: 

NEW EDS

Features

You can now:

Import a manufacturer's EDS configuration, when you set UniStream 

to act as as a scanner.

Create and export an EDS file for adapter nodes you define in 

UniLogic.
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Additional Features

MODBUS New Operations: MODBUS command 0x17 Write/Read Multiple Registers - 

Periodic and Aperiodic.

These operations perform a combination of one Read operation and one 

Write operation in a single MODBUS transaction.

You can now export and import a UniStream MODBUS Master's slave 

definitions, via a proprietary Unitronics file.

You can now assign a MODBUS slave a Unit ID of 0

The addition of a CANbus "Sniffer Filter" can help you monitor--and debug-- 

only the specific CANbus units you specify, according to ID. Note that this can 

be helpful in Servo applications.

You can now assign a machine identifier to an MQTT topic:
{PLC.MAC},{PLC.SN},{PLC.NAME}; PLC Names are assigned in UniApps.

The user name in MQTT Broker Connection has been increased to 128 

characters.

Now supports 1024x768 resolution

CANbus 

"Sniffer 

Filter"

MQTT

VNC Server

OPC UA You now have the option to import client certificate files.

Alarms • You can now Export/Import Alarm groups

• At reboot, the Alarm Summary is now retained

UAC New option - numeric keypad instead of alpha numeric

DT widget You can now display the Descriptions of array members; formerly you could 

only display the index number

Now supports partial hours.RTC Time 

zone

Schedule 

HMI

Emails

Times can now be entered in 12h format (AM and PM)

The email TLS version was upgraded to TLS1.2

FTP Limit the access to FTP to specific folder
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Bugs fixed in this version

These have been fixed in the current version:

• Data Sampler History file: in certain situations, Force Sample did not function correctly.

• UniCAN Communication: When CAN cable was disconnected and reconnected, or CAN power 

cycled, Tx between UniStream and V1040 would fail

• Initial values of retained tags: Sometimes did not update in PLC after regular Download

• Web Trend: Curve Names in Legend, were not visible when the Plot was set to white Fill

• Alarm Summary\Banner: When the alarm name contained the characters " ' " the alarm did 

not display in Alarm Summary\Banner

• SQL Query: Using a constant with parameters that included non-English caused a 'CPU Error'.

• UID-0200E and UID-0200D: Configuration sometimes did not download to PLC.

• Web Server: State machine button would show a false positive compile error when linked to a 

numeric tag that was not INT16

• 'MQTT Send Aperiodic': when sending values that were stored on the same Ladder net, would 

send old values

• email: email with data sample attached as csv.zip, could not be sent

• Store DTI to File: If Append + only CSV options was selected, no file would be generated

• Modem Init Ladder function: In certain cases the function returned Success, when using a 

modem without a SIM

• USBF: Could not write retained tags to the file

• URS-04RT: Would use a UINT16 instead of an INT16, which does not provide for negative 

temperatures. To fix existing projects, the I/O module needs to be removed from Hardware 

Configuration and re-added.

• Alarm file: not all Alarms were saved after after reboot

• MQTT: Cannot connect to Broker with a tag bigger than 1kb

• Message Composer:

• -CRC was not calculated correctly in specific numeric values

• -sometimes failed to build a message if it included a UINT32 value
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UNILOGIC® V 1.28 REV34 UNISTREAM® OS 1.28.58 December 2019

This is a Service Pack version, UniLogic 1.28.34, OS 1.28.58. This service pack is for 

the previous UniLogic version 1.28.26 and OS 1.28.39 released in September.

This version includes the features and bug fixes listed below.

Features

• The Receive buffer size has been increased to 4K RX, enabling larger messages 

to be received via the Rx COM port.

• UniApps now offers an Ignore Uni IO Popup button, located in UniApps under 

System-> System Logs.

• Store UDTF to File:
-Using this function to append data requires a UDTF file. Therefore, if in 
parameter E, you select option 1, Append to File, you must select either options

1 or 2 to create a UDTF file in parameter F. If you select, selected either options
2 or 3 (create .csv only or create .csv.zip only), the status parameter will 

indicate -14: append UDTF file error

-In addition, there is now a new status indication -8: signature file error

Bug fixes - fixed in this service pack

• UniCAN connection between UniStream and EX-RC/RC1: in certain cases, the 

connection was not re-established after disconnection.

• Ethernet/IP scanner: in some cases, the Ethernet/IP scanner was not able to re- 

establish connection with the adapter.

• Trend Widget History Button, HMI & Web: the button was greyed out and 

disabled in the previous version.

• Email: csv.zip Data Sample attachments could not be sent.

• System -> RTC Date -> Day of the week: when the day of the week was set to 

Saturday, the tag value did not update to 7.

• Mail Configurator Widget: under certain circumstances, selecting To/Cc/Bcc 

caused an HMI Application Overload.

• HMI:
- Numeric box: at times, UniLogic did not allow the user to link an array 

member to a numeric box.
- Custom controls: UniLogic displayed these on a black background, appearing 
blurred, instead of being transparent.

• AutoStart: in certain cases, the system did not recover from a crash, if a 

defined CANbus node was not found.

• Multi-Touch keyboard: in certain cases, the Virtual keyboard of multi- touch 

models did not respond.
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UNILOGIC® V 1.28 REV26 UNISTREAM® OS 1.28.30 September 2019

Unitronics fall release for 2019 launches a 

major addition to our All-in-One Solution:

Motion Control. Our full range of Servos and 

Motors is easily programmed in UniLogic; the

Ladder editor offers PLCopen-compliant MC 

Function Blocks. In addition, Unitronics

supplies you with Ready-made Motion code;
this enables you to immediately get moving 

with your Motion system.

UniLogic greatly simplifies servo applications 

by enabling you to:

Drag & drop drives and motors into your 

project: UniLogic automatically defines the correct 

configuration and automatically sets up 

communications for you

Add up to 8 Axes, drag & drop actuators; 

UniLogic automatically converts units

Benefit from automatic calculations: UniLogic 

analyzes the mechanical properties of your 

selections and recommends safe values

Use the Ready-made Motion application to

execute movements, such as Point-to-Point, Jog, and Homing--you can open this 

application and edit as needed to adapt it to your motion requirements

Program Motion Control via drag & drop, 

using industry standard motion Function 

Blocks (PLCopen)

Tune your system using a single 

parameter

Diagnostics: View servo run-time 

performance via UniLogic’s built-in powerful, 

high-speed scope
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Another major feature of this release is OPC UA - UniStream controllers can now act as 

OPC UA servers.

This

release also includes additional features.

Feature List

Motion
Hardware Configuration now offers Servo Drives and Motors.

In addition:

• The Ladder editor offers COM: Servo functions, and PLCopen-compliant MC Function Blocks

• Unitronics supplies you with Ready-made Motion code; this enables you to immediately get 

moving with your Motion system.

OPC UA
UniStream controllers can now function as OPC UA servers.

Digital 

Signature
The Data Table files generated by the function Data Table: Indexed> Store DTI to 

File are now automatically stamped with a digital signature.

Ladder: 

Draw
New Ladder Functions enable you to draw shapes, and groups of shapes on the 

HMI screen (Not yet documented)

RTC

/GMT
UniStream now supports two clocks, Local Time and GMT. You can use these in Ladder 

elements, HMI Widgets, and set them via UniApps.

A new parameter has been added to the RTC struct, Time Zone

Existing Ladder functions Set PLC Time/Date now have a new parameter, Status. 

New System structs have been added, UTC Time and UTC Date

Additional features

IO bus system struct now includes a tag: IO Boot Reset 

Web Data Table element now includes Show Last Update 

Web Data Table width limit reduced to 300px

Caption of the table in Data Tables widgets (HMI/Web) 

SQL now includes Test Connection

CANopen: CANopen nodes can now be duplicated 

HMI:

− Message Boxes can now be aligned

− Message Box Buttons: location can be changed

− HMI Slider: ticks color may be changed

− HMI Trends: Background Color, Grid Color and Plot Color can now be changed
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Alarms offer new options:

− Alarms Silent ACK

− hide the Snooze button

− display the alarm banner only if there's an alarm

•

•

CRC ladder element: new CRC_ASCII option

User Access Control, User options, now has two new options::

− Show User Name; un-check to hide a user's name in the Scroller at login

− Allow Change Password, un-check to hide that option from the user 

Store DTI To file, new options:

− 0 - No CSV File (Only udtf)

− 1 - Create CSV File (ALL udtf/csv/csv.zip)

− 2 - Only csv

− 3 - Only csv.zip

SD Management now includes Data Table files

The following passwords now support up to 16 characters:

− UniApps Administrator

− UniApps Guest

− Upload

− Import/Export App

Project Level Actions: Now includes Safely remove SD and Safely remove DOK (memory stick) 

String tags have been increased to 256 characters

Online mode view: maximum tag size increased from 256 bytes to 514.

Bugs fixed in this version

In certain cases, the Web tables index column ("#") would sometimes present only zeros.. 

Using */ in region or rung comments would cause compilation errors.

If the project was created when the UniLogic UI language was set to Chinese or Czech, SD 

Management did not work.

Web-Server - HyperLink did not work when linked to a Const string tag

While linking an array to FB in Ladder, when selecting the array with the mouse cursor, the 

keyboard input did not function

If the user selected URB modules before selecting a power supply, the modules did not function 

correctly.
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UniLogic V1.26 Rev 90 UniStream OS 1.26.91, May 2019

Hardware Configuration

UniStream PLC Hardware Configuration now offers UniStream PLC +I/Os controllers. 

The series is available in three versions: Pro, Standard, and Basic.

Note that a model number that includes:

• B10 refers to Pro version (e.g. USC-B10-T24)

• B5 refers to Standard version (e.g. USC-B5-RA28)

• B3 refers to Basic version (e.g. USC-B3-T20)

Features

Power 

Features

• Built-in Trends and Gauges, auto-tuned PID, data tables, data sampling, and 

Recipes

• UniApps : Access & edit data, monitor, troubleshoot & debug and more

• Security: Multi-level password protection

• Alarms: Built-in system, ANSI/ISA standards 

I/O 

Options
• Built-in I/O configuration, varies according to model

• Local I/O expansion via Uni-I/O  modules, and UAG-XKxxxx I/O expansion 

adapters

• UniStream Remote I/O Ethernet adapters and modules 

COM
Options

• Built-in ports: 2 Ethernet, 1 USB host, 1 USB device port

• Add-on ports (UAC-CB), available by separate order:

o 1 CANbus port may be added to all models

o RS232/485 ports: according to model technical specifications 

COM •

Protocols

Fieldbus: CANopen, CAN Layer2, MODBUS, EtherNetIP and more. Implement 

any serial RS232/485, TCP/IP, or CANbus third-party protocols via Message 

Composer

• Advanced: SNMP Agent/Trap, e-mail, SMS, modems, GPRS/GSM, VNC Client, 

FTP Server/Client

• Remote Access via any device that supports VNC 
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Programming 

Software

All-in-One software for hardware configuration, communications, and HMI /PLC 

applications, available as a free download from Unitronics.

HMI All UniStream PLCs can display HMI screens on the following devices:

• UniStream Display (USL)

• UniStream Modular HMI panel (USP)

• UniStream Built-in (on the panels integral to the device)

• Any device screen that supports VNC client

HMI screens are designed in UniLogic. In addition to the HMI screens, UniStream 

PLCs offer built-in HMI features, including:

• UniApps : Access & edit data, monitor, troubleshoot, debug, and more

• Security: Multi-level password protection

• Alarms: Built-in system, ANSI/ISA standards

Differences 

between 

B10, B5,

and B3
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Feature B10 Pro B5 Standard B3 Basic

I/O Expansion via Uni-I/O Yes No

Remote I/O Expansion via Ethernet I/O 

Adapter (URB)
Up to 8 1

VFD 32 2

MicroSD Yes No*

Add-on COM modules 3 2

System Memory 6GB 3GB 3GB

MODBUS Slaves Unlimited Up to 8

Ethernet/IP Scanners 16 1

Ethernet/IP Adapters 32 8

Web Server Yes No No

SQL Client Yes No No

MQTT Yes

PID Loops 64 2

Data Sampler/Trends Yes No

CSV files: creating/ reading Yes No

FTP, server/client Yes No

Saving Data Tables to SD Yes No*

Screenshots Yes No

Sending email attachments Yes No

USB device (programming port) Yes No**

* Note that B3 models do not support features requiring SD cards. In addition, Alarm History is not 

retained after PLC reset.

** Note that B3 models may be programmed only via Ethernet cable.
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UniStream PLC 

Models

The built-in I/O configurations are indicated by the last group of digits in the 

model number. For example, USC-B5-TR22 and USC-B10-TR22 have identical 

I/O configurations.

USC-B5-B1 

USC-B10-B1

These models do not have built-in I/Os.

USC-B5-TR22 

USC-B10-TR22

▪ 10 Digital inputs, 24VDC, sink/source

▪ 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits

▪ 2 Transistor outputs, npn, including 2 High speed PWM output channels

▪ 8 Relay outputs

USC-B5-T24 

USC-B10-T24

▪ 10 Digital inputs, 24VDC, sink/source

▪ 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits

▪ 10 Transistor outputs, pnp, including 2 PWM output channels

USC-B5-RA28 

USC-B10-RA28

▪ 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter input 

channels

▪ 2 Analog inputs, 0÷10V / 0÷20mA, 14 bits

▪ 2 Temperature inputs, RTD / Thermocouple

▪ 8 Relay outputs

▪ 2 Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

USC-B5-TA30 

USC-B10-TA30

▪ 14x Digital inputs, 24VDC, sink/source, including 2 High speed counter 

input channels

▪ 2 x Analog inputs, 0÷10V / 0÷20mA, 14 bits

▪ 2 x Temperature inputs, RTD / Thermocouple

▪ 10 x Transistor outputs, pnp, including 2 PWM output channels

▪ 2 x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

USC-B5-R38 

USC-B10-R38

▪ 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input

▪ 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits

▪ 12 Relay outputs

USC-B5-T42 

USC-B10-T42

▪ 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input

▪ 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits

▪ 2x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

▪ 16x Transistor outputs, source (pnp), including 2 PWM output channels

USC-B3-R20 ▪ 10 Digital Inputs,

▪ 2 Analog Inputs

▪ 8 Relay Outputs

USC-B3-T20 ▪ 10 Digital inputs,

▪ 2 Analog Inputs, 8 Transistor Outputs, pnp, including2 PWM Outputs



USB Action 

Files: 

Interact 

with the 

PLC

This is a special UniStream PLC feature; it enables the user to carry out certain task 

without the need to interact with the PLC via an HMI panel.

Programmers can create Action files in UniLogic and save them to a USB mass storage 

device, such as a flash drive. The end user can plug the drive into the PLC's USB port, 

and then press the Confirm button on the front of the PLC to run the file and execute 

the Actions.

Actions include 

updating firmware and 

network settings, 

downloading 

applications, extracting 

log files, and more.

In order for Actions to 

execute, the PLC must 

have permission. USB 

Action Permissions are 

set in Hardware Co, 

and are written to the 

PLC at download
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UniStream 

Remote

I/O: New 

Models

Hardware Configuration now shows over 20 new UniStream Remote I/O modules.

Digital Inputs

URD-1600-8 16 Digital Inputs (Sink / Source), 24VDC

URD-3200-4 32 Digital Inputs (Sink / Source), 24VDC

URD-0400B 4 Digital Inputs, 120VAC

URD-0400C 4 Digital Inputs, 240VAC

Encoder / High Speed Counters

URD-0200E 2 High Speed Counters / Encoder Inputs, 24VDC

URD-0200D 2 High Speed Counters / Encoder Inputs, 5VDC

Digital Outputs

URD-0008CI 8 Digital Outputs, (Source), 24VDC/2A

URD-0016CG-8 16 Digital Outputs, (Source), 24VDC/0.3A

URD-0032CG-4 32 Digital Outputs, (Source), 24VDC/0.3A

URD-0008NI 8 Digital Outputs, (Sink), 24VDC/2A

URD-0016NG-8 16 Digital Outputs, (Sink), 24VDC/0.3A

URD-0032NG-4 32 Digital Outputs, (Sink), 24VDC/0.3A

Relay

URD-0004SK 4 Solid State Relay, 240VAC/DC, 0.5A

URD-0004SM 4 Solid State Relay, 110VAC/DC, 1A

URD-0004SN 4 Solid State Relay, 24VAC/DC, 2A

Analog Inputs 12 bit

URA-1600O-8 16 Analog Current Inputs 12bit

URA-1600P-8 16 Analog Voltage Inputs 12bit

Analog Inputs 16 bit

URA-1600T-8 16 Analog Current Inputs 16bit

URA-1600U-8 16 Analog Voltage Inputs 16bit

Analog Outputs 12 bit

URA-0004X 4 Analog Voltage Outputs 12bit

URA-0016X-8 16 Analog Voltage Outputs 12bit

Analog Outputs 16 bit

URA-0016Z-8 16 Analog Voltage Outputs 16bit

Temperature

URS-04RT 4 RTD / Resistance

URS-04TC 4 Thermocouple / mV

URS-08RT-2 8 RTD / Resistance

URS-08TC-2 8 Thermocouple / mV



HART Support: 

New Uni-I/O

The new UNI-I/O model UIA-0800NH, offers 8 analog channels with HART 

communication.

UAG-CX-

XKPLXXXX

UniStream CX Long-range I/O expansion adapter + embedded Power Supply for 

UniStream controllers offering jacks, such as the UniStream Built-in series.

 Available in lengths of 600, 1200, 1500, 2000, 3000 cm. 

Additional Features

Set PLC Configuration 

from file

A new Ladder function enables you to load configuration files that modify the 

parameters shown below.

Function Editable Parameters

Email Accounts User Name, Password, 
Outgoing Server Settings, 
From

FTP Client User Name, Password, Port, 
Remote IP

FTP Server User Name, Password, Port, 
Read Only

FTP RAM Server User Name, Password, Port

Panel: Network 
settings

IP Address, Subnet Mask, 
Default Gateway

COM Modbus Baud Rate, Data Bit, Parity

COM txrx/com
Bit, Stop Bit

Switch Case You can define groups of Switch Cases, and then run them via the Switch 

Case Ladder function.

This enables you to run multiple Compare operations in a single case, and use 

the results to drive one or more events.
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SQL: Stored 

procedure

When you run a stored procedure, you can ignore @ placeholders by checking 

the "Is Executing a stored procedure" checkbox for each query.
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email Attachment, 

Alarm Logs

You can now attach 

Alarm Logs as a .csv file.

New Ladder 

Elements

• Zip File from SD: Locate a file in an SD folder, zip it in .zip or gz format, and 

place it in a destination folder on the SD.

• FTP Compare File: locate a file on a remote FTP Server, compare it to a file 

on the controller's SD card, and overwrite the SD file if it is different.

HMI Editor 

Additions
• HMI PDF Viewer element: now offers Indirect file name support

• UniLogic HMI Toolbox: sort custom controls according to ABC

• Password box and Text Box HMI: now includes Numeric keypad support.

Alarms Alarms now support several new features:

• Global actions:

o - Create/close and Zip Alarm log

o - Clear all Alarms

o - Clear and Ack all Alarms

• Each individual Alarm now includes:
- Alarm Cleared bit
- Alarm Suppression bit

• New HMI Actions:
- Clear all Alarms
- Clear and Ack all Alarms

• New Alarm Ladder Elements:
- Modify Alarm texts from CSV file
- Reset cleared Alarm state

Default Language: 

Korean

You can now, when selecting a controller, under Properties/Regional Settings, 

select Korean, causing the controller to display the Korean keyboard when a 

user needs to enter data via the HMI screen.

Modbus Modbus Groups have been increased to up to 128 groups

Bugs fixed in this version

• RTC Date/Time is now editable while in "Online" mode

• Web Server: State Machine buttons are now visible as expected

• Web Server: Web Page Roles can now be duplicated

• Online mode: Would sometimes disconnect randomly

• Table Recipe: If the name of the linked struct was changed, the table values would not be visible

• UniLogic gives compilation error if an SQL query includes an alias name

• Duplicating an array inside a struct would not keep members’ names and comments

• Changing member of array name as Function In sometimes changed the current view

82



83


	Diapositive 1
	Diapositive 2
	Diapositive 3
	Diapositive 4
	Diapositive 5
	Diapositive 6
	Diapositive 7
	Diapositive 8
	Diapositive 9
	Diapositive 10
	Diapositive 11
	Diapositive 12
	Diapositive 13
	Diapositive 14
	Diapositive 15
	Diapositive 16
	Diapositive 17
	Diapositive 18
	Diapositive 19
	Diapositive 20
	Diapositive 21
	Diapositive 22
	Diapositive 23
	Diapositive 24
	Diapositive 25
	Diapositive 26
	Diapositive 27
	Diapositive 28
	Diapositive 29
	Diapositive 30
	Diapositive 31
	Diapositive 32
	Diapositive 33
	Diapositive 34
	Diapositive 35
	Diapositive 36
	Diapositive 37
	Diapositive 38
	Diapositive 39
	Diapositive 40
	Diapositive 41
	Diapositive 42
	Diapositive 43
	Diapositive 44
	Diapositive 45
	Diapositive 46
	Diapositive 47
	Diapositive 48
	Diapositive 49
	Diapositive 50
	Diapositive 51
	Diapositive 52
	Diapositive 53
	Diapositive 54
	Diapositive 55
	Diapositive 56
	Diapositive 57
	Diapositive 58
	Diapositive 59
	Diapositive 60
	Diapositive 61
	Diapositive 62
	Diapositive 63
	Diapositive 64
	Diapositive 65
	Diapositive 66
	Diapositive 67
	Diapositive 68
	Diapositive 69
	Diapositive 70
	Diapositive 71
	Diapositive 72
	Diapositive 73
	Diapositive 74
	Diapositive 75
	Diapositive 76
	Diapositive 77
	Diapositive 78
	Diapositive 79
	Diapositive 80
	Diapositive 81
	Diapositive 82
	Diapositive 83

